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Chapter 1 

Sample Session 

When you choose "Spreadsheet" from the Synergy Main Menu, you see a spread­
sheet in a window. A file selection menu requests that you choose an existing 
spreadsheet file or else press INSERT HERE to begin creating a new spreadsheet. 
In this Sample Session, you will create a new spreadsheet. Therefore, press 
INSERT HERE and enter the name EXPENSES for the spreadsheet's file. 

After you enter the file name and press RETURN or DO, Spreadsheet removes 
the file selection menu and places a blinking cursor bar in the Spreadsheet 
window. The Spreadsheet window you see initially is shown in Figure 1-1. 
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Figure 1-1 
The Spreadsheet Window 

On the left of the window are row nurnbers identifying 12 rows. Across the top 
of the window are colunm letters identifying five columns. The columns and 
rows intersect to form cells. Each cell has a cell narne formed by its column 
letter and row number. Initially, the cursor bar rests on cell Al, defined by the 
intersection of column A and row 1. 

The spreadsheet is much larger than the 60 cells that are visible in the window, 
since it has 52 columns and 256 rows. At start-up the window shows the upper­
left corner of the spreadsheet, as illustrated in Figure 1-2. 
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Figure 1-2 
The Window and the Spreadsheet 

You can easily move the window to other areas of the spreadsheet. 

MOVING THE CURSOR 

There is a cursor bar in the Al cell at start-up. The cursor bar designates the 
Al cell as the current cell. The cell name is shown below the title line of the 
window, followed by an equal sign. This line always shows the cell contents. 
When you start Spreadsheet, all cells are clear, so the cell contents line shows 
that the Al cell is clear. 

Let's experiment by moving the cursor bar. 

Example: Moving the Cursor 

1. Press ,J. once. The cursor bar moves from Al to A2. Note how the 
cell contents line now reads A2 = . 

2. Continue to press -1, until the cursor bar moves to A13. When the 
cursor moves beyond A12, Spreadsheet scrolls row 13 into view. 

3. Press..,. until the cursor bar moves to N13. Spreadsheet scrolls new 
columns into the window as needed. None of the cells in the original 
window are visible now. 
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4. Press FIND. The cell contents line reads "Find." Type A1 and press 
RETURN. The cursor bar quickly moves back to its initial location. 
This is a quick way to move around the spreadsheet. 

ENTERING DATA 

Each of the cells holds a value. That value appears to the right of the equal 
sign in the cell contents line. So far our spreadsheet cells contain no values. 

Let's enter some values. 

Example: Entering Data 

1. Move the cursor bar to cell B2. 

2. Enter 123 and press RETURN. Spreadsheet echoes your keystrokes 
in the cell contents line. When you press RETURN, the number 123 
becomes the value of cell B2. 

(Cell B2 shows the number as 123.00 because it is using the default 
display format. You will learn how to change the format later in the 
Sample Session.) 

3. Move the cursor bar down and enter the numbers 456 in cell B3, and 
789 in cell B4. 

If you make a mistake while entering values, use the~ key. If you need to 
correct or change a value after you have pressed RETURN, either you can move 
the cursor bar to the cell you want to change and type the correct value, or 
you can edit the cell (see "Editing Cell Contents" in Chapter 2). For now, let's 
use the simpler method of moving the cursor and typing the correct value. 

USING FORMULAS 

So far, we have entered number values into the spreadsheet. You can also enter 
formulas that Spreadsheet uses to perform arithmetic functions. In this example 
we will enter a formula to sum the values you have entered. 

Example: Using Formulas 
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1. Move the cursor bar to cell C6 and enter SUM(B1 :B5) <RETURN> 
Spreadsheet sums the first five cells of column B and puts that sum 
into cell C6, as in Figure 1-3. 



123.00 
456.00 
789.00 

, ; ~,, • • ~ . ,. , : ' ·. ;:, . ,-' ..• , . 
.;,.;_:,.., __ .... ! •. ~,,.,.,o,6.;,,."" - ,,>~ ~.-,n.;,,..,.,. .. --;,.,.., . ..,,,_.~,.~-•.6/,-.•.,:,,..,,.,N--,J...,d""°'~ •M_,;.,-4,.,.., ,.,. ... c>"-•c..-..."<',,_ -,,l ••• ~ ,.-j .:~,:C 

Figure 1-3 
A Sum Calculation 

SAMPLE SESSION ; CHAPTER 1 

,•, ..,,;," 
, .,, __ ~• ,,..,.,,, -· "_._,_,___,,.,,., 

Note that the cell contents line contains the formula SUM(Bl:B5), not 
the value 1368.00. Spreadsheet remembers that you want cell C6 to 
have the sum of five cells in the B column. You have made the value 
of cell C6 dependent on the values in those B column cells. Let's see 
how this dependency works for you. 

2. Move the cursor bar back to cell B4, and change its value to 788 
instead of 789. Do this by entering 788 <RETURN>. The old value in 
cell B4 is replaced by the new value. Notice that the value in cell C6 
changes instantly to 1367.00, reflecting a new sum for the five cells in 
column B. (See Figure 1-4.) 
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1367,00 

Figure 1-4 
Reevaluation of the Sum 

This instant computation of the dependent cell C6 is called automatic evaluation. 

This is a simple example of the most powerful feature of Spreadsheet. You can 
establish dependencies between cells and, by changing values in certain cells, 
can instantly see the effect of the change in the dependent cells. 

In this example, five cells in column B were summed. More selective computations 
are possible, and chains of computations are possible in which the value in one 
cell is computed and then used in a computation to find the value of another 
cell. 

LABELING THE SPREADSHEET 

There are now four cells containing numbers on the spreadsheet. But the numbers 
in the example convey no meaning. Do they represent dollars, inches, pencils? 
In your use of Spreadsheet you will be dealing with numbers drawn from real 
situations. It is easy to become confused unless you label the numbers. 
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Before putting any more numbers on the spreadsheet, let's add some text to 
identify the existing numbers. 

Example: Labeling the Spreadsheet 

1. Move the cursor bar to cell Bl and enter 'Expenses <RETURN>. The 
quote identifies the data as text. The label tells us that the numbers 
in column B represent dollar amounts, such as business expenses. 

2. Enter text in cells A2, A3, and A4 as shown in Figure 1-5. Be sure 
to start the text with a quote! You can use either a single or a 
double quote. The labels in column A identify the type of expense 
for us. 

3. Move the cursor to cell D6 and enter '(total) <RETURN>. 

Figure 1-5 
Labels on the Spreadsheet 

Exp1nses 
123.00 
456.00 
788.00 

1367. ocxo:mm• 

You label cells for your own benefit, so that you can remember what the numbers 
mean. The labels do not have any meaning to Spreadsheet. Notice that the label 
"(total)" does not cause any additions to occur. Cell C6 has a total (sum) in it 
only because you specifically set the cell contents to a formula, SUM(Bl:B5). 
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Furthermore, Spreadsheet does not know whether the text that you supply for 
a cell acts as a label for the cells below, above, or to the right or left of the 
label. Only you know the association between text cells and number cells. 

Now that the spreadsheet has been labeled, let's return to the manipulation of 
numbers. 

MORE ON USING FORMULAS 

When you made cell C6 dependent on the values in cells Bl through B5, you 
were using a formula. You enter formulas as values into spreadsheet cells. Then 
Spreadsheet performs the computations for you by using the values referenced 
in the formula. 

Suppose the total expenses represented by cell C6 are to be shared between 
two departments. Department A pays for 18 percent of the expenses, and 
department B pays the rest. You want to show this on the spreadsheet. 

Example: Using Formulas 
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1. Move the cursor bar to cell CS, and enterC6*.18 <RETURN>. Note 
that you only enter the right side of the equation. The left side is 
provided on the cell contents line. Spreadsheet evaluates this formula 
and sets cell C8's value to 18 percent of cell C6's value. Now cell C8 
is dependent on cell C6, and cell C6 is dependent on cells Bl to B5. 

2. Label the number in cell CS by putting · Dept A: in cell BS. 

3. Put the label 'Dept B: in cell B9. 

4. Move the cursor bar to cell C9 and enter C6-C8 as the formula for 
department B's share of the expenses. Spreadsheet computes the 
value of C9. Now C8's value is dependent on C6, and C9's value is 
dependent on both C6 and CS. 

5. Move the cursor bar back to cell B4 and enter 924 . Watch 
Spreadsheet automatically evaluate cell C6 to the new total of Bl, 
B2, B3, B4, and B5. Then it reevaluates cells CS and C9. 
Spreadsheet always does the calculations in the correct order. 

6. With the cursor bar still on cell B4, reenter788 ., so that our Sample 
Session continues with the same numbers. 
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REFERENCING CELL VALUES 

Let's copy one of the computed results to a new location, and then use the copy. 
We will use cells that are all within the window, so that it will be easy to watch 
what is happening. 

Example: Referencing Cell Values 

1. Move the cursor bar to cell All and enter the text 'Dept A(cpy). The 
text in All serves as a reminder of where the A12 value comes from. 

2. In cell A12 enter CB. Notice that Spreadsheet instantly copies C8's 
value into the A12 cell. 

3. Move to Ell and enter the text 'Dept B(cpy). 

4. In cell B12 enter C1 o. (Apparently a mistake, but try it.) Your 
spreadsheet should resemble Figure 1-6 . 

Figure 1-6 
A Pending Cell 

. 
Exptnlil!s 

123.00 
4!56.00 
788.00 

1367.00(totall 

246.06 
1120.94 
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Spreadsheet accepts the formula B12 = ClO, but during the evaluation 
it finds that ClO is clear (contains no value). Since Spreadsheec; 
cannot evaluate B12, it supplies a warning message PEND, indicating 
that Spreadsheet needs additional values before it can evaluate the 
cell. 

5. Move the cursor bar to cell ClO and enter O. The ClO cell is no 
longer clear; it now contains a value. Accordingly, Spreadsheet 
evaluates the formula for the B12 cell, and removes the PEND 
message. 

6. Now enter the text '123 into cell ClO. Although it may look like a 
number, Spreadsheet knows that ClO contains text. The formula in 
the B12 cell calls for a numeric value in the ClO cell. Spreadsheet 
cannot compute the value for the B12 cell and marks it with a 
different message, UNKN. When ClO was clear, Spreadsheet 
assumed that you had not supplied its value yet, so it marked 
the B12 cell with a PEND message. Now that ClO contains text, 
Spreadsheet uses a different error message to alert you to a possible 
error. 

7. Move the cursor bar back to B12 and correct the mistake by entering 
C9. 

8. Move the cursor bar to cell ClO and enter' <RETURN>. This cleans 
up our example by replacing the 123 with blank text. 

When you reference a cell in a formula, the cell must contain a numeric value 
for Spreadsheet to evaluate it properly. Otherwise, Spreadsheet places warning 
messages like PEND and UNKN in the cell. 

An exception is that some functions, like the SUM function earlier in the Sample 
Session, can reference a range of cells. Spreadsheet ignores clear cells and cells 
that contain text within a range. The next example shows another possible 
error. 

CIRCLE OF DEPENDENCIES 

You can see that formulas are used to copy numeric cell values to other cells 
and to compute new values. It is possible to create a circle of dependencies, in 
which one cell's formula references another cell with a formula that references 
another cell with a formula, that ultimately references the starting cell. If 
Spreadsheet did not detect such a condition, it would never stop attempting to 
evaluate these cells. 
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Let's see what happens when a circle of dependencies is created. 

Example: Circle of Dependencies 

1. Move the cursor bar to cell B5 and enter A12. This makes cell B5 
dependent on cell A12. Remember, B5 is being summed along with 
other B column cells to yield the total in cell C6; cell C6 is being used 
to compute cell C8; and cell C8 is being copied to cell A12. Thus, 
making B5 equal to A12 creates a circle of dependent cells. 

Spreadsheet recognizes this circular definition and marks all these 
cells with a warning message, CIRC, to indicate that they have a 
circular definition, as shown in Figure 1-7. 

Figure 1-7 
A Circle of Dependent Cells 

Exptnns 
123.00 
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When the cells are marked with the CIRC error message, the cells 
lose their previously displayed numeric values. The cells that depend 
on them see text (the error message CIRC) in the circular cells. 
These dependent cells, which are not part of the circular definition 
but which depend on cells in the circular definition, are marked with 
the UNKN message. 

13 
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2. Correct the circle of dependency by setting cell B5 to a blank value. 
Remember, entering '<RETURN> blanks the cell. Immediately, you 
see that Spreadsheet removes all CIRC and UNKN messages and 
restores the previous values to all cells. 

This example shows how one small change in cell Bl altered most of the numbers 
on the spreadsheet. The CIRC and UNKN messages are two types of error 
messages that alert you to a problem. Sometimes the cause of an error message 
is obvious, and you can correct it immediately. At other times, the cause of an 
error message may not be obvious. See "Error Messages" in Chapter 2 for more 
information on possible causes. 

For now, though, let's examine this particular error message as an example of 
how to handle errors. 

A CIRC error is a very useful warning. It is a clear indication that your formulas 
have a flaw. The flaw may be a simple typing mistake, in which you referred 
to the wrong cell in a formula. The flaw may also be in the logic of the formulas. 
You may be incorrectly stating the relationships between the numbers. That's 
what happened here. You had expenses in the Bl to B5 cells. You derived some 
new numbers from those expenses with the formulas in cells C6 and CS, and 
then tried to feed one of those derived values back into the computation as an 
original expense. 

When a CIRC error occurs and the cause of the error is not immediately obvious, 
you may have to move around the circle to find the problem. You start at any 
CIRC cell, usually the one that you just altered, and examine its formula. The 
formula will have a reference to one or more cells. At least one of these cells 
will also have a CIRC message. You then move to that cell and look at its 
formula. Again it will reference one or more CIRC cells. Eventually you will 
find a reference to the starting cell. By moving around the circle you can trace 
the ci:.:cle of dependencies and eventually find the problem. 

This example illustrates the benefit of labeling. A circle of dependencies may 
occur on a large spreadsheet. Tracing the circle of dependent cells may involve 
moving the window to other areas of the spreadsheet. Careful labeling will help 
you to analyze each formula in the circle. 

14 
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FORMATTING THE SPREADSHEET 

We have seen some of the default spreadsheet formatting characteristics, such 
as left justification of text and two decimal places in numbers. These are but 
two of many characteristics that you can change by using Spreadsheet's flow 
menus. Let's see how you can alter the appearance of the spreadsheet. 

Example: Formatting the Spreadsheet 

1. Place the cursor bar in cell C6 and press ADDTNL OPTIONS to get 
Spreadsheet's Format Menu, as in Figure 1-8. 

Figure 1-8 
Format Menu 
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2. With the cursor bar on the "Cells" option, press DO. Spreadsheet 
displays a menu that describes the current cell's format, as in 
Figure 1-9. 
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Figure 1-9 
Current Cell Format Menu 

3. Move the cursor bar to the "Currency" option and press DO to 
change the Currency setting to ON. This causes Spreadsheet to use 
the currency symbol (by default the dollar sign). 

4. The cursor bar is now on the "Thousands" option. Press DO to 
change the Thousands setting to ON. This causes Spreadsheet to 
insert a separator (by default a comma) between thousands. 

5. Press EXIT to complete the changes. Notice that the display of cell 
C6 changes from 1367.00 to $1,367.00. 

This example changed only the format of cell C6. Other numbers in the spreadsheet 
are not preceded by a dollar sign. You can change the format of single cells, as 
we did here, or a group of cells. Changing the format of a group of cells requires 
that you select them prior to changing the format. The select operation is 
described in the next example. 
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In this example we did not change the decimal places, justification of numbers 
or text, or the rendition, since the current settings met our needs. See the 
description of the Format Menu in Chapter 3 for complete details on these 
formatting options. 

Chapter 3 also describes formatting options available on the Personalize Menu. 
That menu enables you to change the currency symbol, the decimal point, and 
the thousands separator among other things. Use that menu to alter these 
characteristics to accommodate the conventions used in countries other than the 
United States. 

REORGANIZING THE SPREADSHEET 

The current spreadsheet is somewhat difficult to read because we have placed 
labels above and to the left and right of numbers. We should have used a more 
consistent method of labeling. The spreadsheet is also crowded. Suppose that 
we wanted to add some more expenses in column B. As you create and use a 
spreadsheet, you often want to reorganize it to expand or contract some areas 
and to make it easier to read and use. 

Moving Data 

Let's use the Edit Menu to make the labeling more consistent. We will move 
the labels in cells A2, A3,· and A4 to the other side of the numbers in column 
B. To do this we will use the Spreadsheet's ability to select an area and copy 
data to a new location. The next example shows you how to select and copy 
text. 

Exampl~: Selecting and Copying Text 

1. Move the cursor bar to cell A2 and press SELECT. Notice that the 
cell contents line which previously showed A2 ='Telephone,' now 
shows A2:A2 A2 = 'Telephone.' The cell range A2:A2 designates the 
selected area (one cell). 

2. Move the cursor bar down to cell A4. Notice that the selected area 
grows as you move the cursor bar, and the cell range changes to 
A2:A4. 

3. Press SELECT again. This locks the selected area as A2:A4, which is 
indicated in the cell contents line by the addition of square brackets 
around the cell range, [A2:A4]. Locking the selected area allows you 
to move the cursor bar to the new area without further extending the 
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selected area. The locked area designates the cells to be copied (the 
sending area). 

4. Move the cursor bar to cell C2, which is the upper left corner of the 
area where the cells are to be copied (the receiving area). 

5. Press F12 to see the Edit Menu, as shown in Figure 1-10. 

Otpt A: 
D1pt B: 

. '· .. 

S1,367,00(totall 
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. . 
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Figure 1-10 
Edit Menu 

6. Move the cursor bar to "Copy" and press DO. The sending area cells 
are copied to the receiving area. The copy did not alter the sending 
area cells, so the labels now appear on both sides of the numbers. 

7. Press F12 and choose the "Reselect" option. This reestablishes the 
old sending area as the selected area. 

8. Press F12 again and choose "Clear cells" to remove the values of all 
cells in the selected area. 

Be sure to move the cursor to the area where you want the cells to be copied 
before you choose "Copy" from the Edit Menu. If there is any data in the area 
copied to, it is overwritten during the copy operation. 
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The area that you just copied contains only text, but you can also copy an area 
that contains numbers. 

When cells containing numbers are copied, you must consider the effect of the 
copy on formulas. Formulas in the sending area cells· that are copied to the 
receiving area cells might be altered during the copy. The next example shows 
how copying can affect formulas. 

Let's shift cells C6 and D6 leftward by one cell so that the total of cells Bl to 
B5 will be directly beneath those cells (in cell B6). 

Example: Copying Numbers 

1. Move the cursor bar to cell C6 and press SELECT. 

2. Move the cursor bar to cell D6 and press SELECT to lock the sending 
area. The cell contents line should read [C6:D6]. 

3. Now move the cursor bar to cell B6 (the receiving area) and .press 
F12 to display the Edit Menu. 

4. Choose the "Copy" option from the Edit Menu. The cells are moved, 
as shown in Figure 1-11. 
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Figure 1-11 
The Spreadsheet After a Copy 
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Cell B6 now holds the formula that was in cell C6, but the copy 
operation altered the formula so that it now references the cell range 
Al:A5. Since the cells in column A contain text, Spreadsheet places 
an UNKN message in B6. (When you become more familiar with 
Spreadsheet, you will see that there is a way to prevent Spreadsheet 
from altering the formula; see "Copy'' in Chapter 3.) 

5. While the cursor bar is still in cell B6, reenter the formula 
SUM(B1 :B5) to restore the correct range. Spreadsheet removes the 
error message and restores the correct total in cell B6. Notice that 
clearing the sending area is not as simple as before, since the sending 
and receiving areas overlap. 

6. Move the cursor bar to cell D6 and press F12. 

7. Choose the "Clear cells" option from the Edit Menu. This clears only 
cell D6. Notice that cells that depended on cell C6, directly or 
indirectly, now have an UNKN value, since C6 now contains text. 

8. Move the cursor bar to cell C8 and make it dependent on cell B6 by 
entering 86:~. 18. This restores the values in C8 and A12. 
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9. Similarly, change the contents of C9 to B6-CS . This restores the 
values in C9 and B 12. 

After a copy operation, you should carefully consider which formulas may be 
affected. In this case all cells with formulas were flagged by error messages. 
You cannot rely on this to happen, however, since formulas may reference 
numeric cells (that are incorrect after the copy), and the error may go undetected. 
Formula modification during a copy is discussed in greater detail in Chapter 3, 
under "Copy." 

Adding and Removing Rows or Columns 

Spreadsheet makes it easy for you to add and remove rows and columns as your 
needs change. Suppose that you decide to include some new expenses in the 
spreadsheet. You need to add three more expenses in the B column, below the 
"Lodging" expense. You could move rows 6 to 12 down using a copy operation 
and then clear the cells that you need. However, there is a simpler way, using 
the "Insert" operation. Similarly you may decide to remove data. The following 
examples show you how to do both. 

Example: Adding Rows or Columns 

1. Move the cursor bar to cell B5, and press F12 to display the Edit 
Menu. 

2. Choose the "Insert" option. Spreadsheet asks if you want to insert a 
row or a column. 

3. Select "Row" and press DO. A row of clear cells is inserted at row 
B5, pushing all lower rows clown by one row. 

4. Move the cursor bar to cell B7, which now contains the total. Notice 
that the formula for cell B7 has changed from SUM(Bl:B5) to 
SUM(Bl:B6). Likewise the formulas for cells C9, ClO, A13, and B13 
have all been adjusted to reference new cell names. Spreadsheet 
adjusts all formulas that contain references to cells that are moved by 
the insertion of the new row. You can insert additional rows (or 
columns) by repeating this process. 

When a row or column is inserted, row 256 or column AZ is pushed off the edge 
of the spreadsheet. If that column or row contains values, the values are lost. 

21 



CHAPTER 1 SPREADSHEET USER'S GUIDE 

If there are references to cells in the lost row or column, Spreadsheet adjusts 
those cell references to refer to the newly inserted row or column. Since the 
new row or column is clear, this may produce PEND messages in the referencing 
cells. 

You may decide to discard some work that you have done on the spreadsheet, 
but to retain other areas. You might want to close up the empty area by removing 
some columns or rows. Use the "Remove" option on the Edit Menu to remove 
columns or rows. 

\,Vhen you remove a column or row, the columns to the right or the rows below 
the removed area move into the vacated area. As with inserting, Spreadsheet 
automatically adjusts references to cells in the moved area. 

If there are references to the row or column that is removed, those references 
are changed to refer to row 256 or column AZ. It is as if the column or the row 
being removed is cleared of all values and moved to the right or bottom of the 
spreadsheet. 

Example: Removing Rows or Columns 

22 

1. Place the cursor bar on cell B6, and press F12. 

2. Choose the "Remove" option from the Edit Menu, then choose the 
"Row" option. Row 7 moves up to row 6, but cell B6 receives a 
CIRC message. The cell contents line for B6, B6 = SUM(Bl:B256), 
shows that the cell range for the SUM function now references B256. 
Removing row 6 changed all references to cells in row 6 to the 
corresponding cell in row 256. The formula SUM(Bl:B6) became 
SUM(Bl:B256). The formula is circular since it is trying to compute 
a sum for a cell that is itself within the range of cells being summed. 

3. With the cursor bar on cell B6, enter SUM(B1 :85) to remove the 
circular definition. (If you had removed row 5 instead of row 6, there 
would have been no error, since no cell in row 5 was explicitly 
referenced in a formula.) The spreadsheet resembles Figure 1-12 at 
this point. 
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Figure 1-12 
The Final Spreadsheet 
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If you need help while using Spreadsheet, press HELP. Spreadsheet gives you 
HELP based on the operation you are performing and also gives you access to 
the HELP index. 

Example: Using HELP 

1. Press F11 to view the File Menu, position the cursor on an option 
and press HELP to get more information about that option. You are 
given HELP and the opportunity to get more information. 

2. Position the cursor on the "HELP index" option and press DO. You 
are shown an index of HELP information. 

3. Choose any topic and press DO. HELP on that topic appears on your 
screen. 

4. When you have the information you want, press RESUME to leave 
HELP. 
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SAVING THE SPREADSHEET 

You have now completed work on the sample spreadsheet and want to save it. 

Example: Saving the Spreadsheet 

1. Press F11 to see the File Menu. 

2. Choose the "Save Spreadsheet" option. Spreadsheet asks you to 
confirm the file name EXPENSES. WRK. 

3. Press DO. This saves the entire spreadsheet, including cell formats 
and cell contents. 

Your spreadsheet is now stored in a file named EXPENSES. WRK. Chapter 3 
describes other options for saving your spreadsheet. 

You can reload the saved spreadsheet by choosing the "Load spreadsheet" option 
on the File Menu, and choosing EXPENSES.WRK when prompted for the file 
name. When you next start Spreadsheet, choose EXPENSES. WRK to reload 
your saved spreadsheet. 

EXITING FROM SPREADSHEET 

When you want to leave Spreadsheet, press EXIT. Spreadsheet displays a menu. 
This menu allows you to save any changes you have made since you entered 
Spreadsheet or since you used the File Menu to save your data. 

If you want to abandon any changes you have made, select "Quit" and press 
DO. Spreadsheet returns you to the Synergy Main Menu. If you want to save 
your changes, select "Save" and press DO. Spreadsheet saves your information 
in a data file. If you used the File Menu earlier to save your data, this data file 
is the file you specified then. Otherwise, it is the file you specified when you 
entered Spreadsheet. After the data file has been written, Spreadsheet returns 
you to the Synergy Main Menu. 

If you want to return to your spreadsheet and continue working instead of 
exiting Spreadsheet, press EXIT again. 
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Chapter 2 

Concepts 

As you work with Spreadsheet you perform operations that affect individual 
cells, selected areas of the spreadsheet, and the entire spreadsheet. This chapter 
covers all three. 

It begins with a quick review of some of the basic terminology used in the 
sample session. The process of selection comes next, because it applies to cells 
as well as larger areas of the spreadsheet. Operations on cells and operations 
on the spreadsheet follow in that order. 

BASIC TERMINOLOGY 

The spreadsheet consists of cells, arranged in columns and rows and viewed 
through a window. Each cell has a name formed from its column letter and row 
nurnber. For example, Al indicates the cell located at the intersection of the 
first row and first column. 

You enter data into a cell by placing the cursor bar on the cell and typing in 
either text or a number. The data you enter into the cell is the cell contents. 
As you enter data, the cell contents are displayed on the cell contents line at 
the upper left corner of the spreadsheet. The data is also displayed in the cell 
itself. The way numbers display in the cell may be different from the cell contents 
line. This results from the different types of number values Spreadsheet allows 
and the format settings in force. 
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A number value is either a constant value or is derived from a formula that is 
associated with the cell, making the cell dependent on number values in other 
cells. Formulas consist of arithmetic expressions and may include the use of 
predefined functions. A cell is referenced in formulas by its cell name. Unless 
the cursor is on a particular cell, you cannot know whether the number displayed 
is a constant or the product of a formula. You can always check the cell contents 
by moving the cursor to the cell and reading the cell contents line. 

A rectangle of adjacent cells is called a cell range and is referenced in formulas 
by the cell names of any two diagonally opposite corner cells. A cell range can 
be one column as in Al:A6 (6 cells), or one row as in Al:Dl (4 cells). A cell 
range can also consist of several rows and columns as in Al:D6 (24 cells). 

Each cell's appearance on the screen is determined by formatting characteristics 
such as justification, decimal places, currency sign, column width, rendition, etc. 

SELECTION 

The process of selection enables you to specify which part of the spreadsheet a 
particular operation will affect. You can select an individual cell or a rectangular 
block of adjacent cells. You cannot select cells that are not adjacent. 

Some spreadsheet operations, like copy, require that you select an area. Others, 
like clear and blank, allow you to select an area or perform the operation on an 
individual cell. When you want to perform an operation on a selected area, you 
must select the area prior to requesting the operation. 

You select an area as follows: 

28 

1. Move the cursor bar to a cell in one of the corners of the area to be 
selected and press SELECT. 

2. Move the cursor bar to the diagonally opposite corner of the area to 
be selected. 

3. Press SELECT again, if the operation that you are about to request 
requires you to move the cursor bar to another cell. (If the operation 
does not require this, you need not press SELECT a second time.) 
The second press of SELECT locks the selected area so that 
additional movement of the cursor bar will not alter the selected 
area. 
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The selected area is highlighted in the window, and is also shown as a cell range 
at the left encl of the current contents line. After you execute the operation on 
the selected area, the selected area is automatically canceled. 

If you decide not to use the selected area, you can cancel the selection with the 
CANCEL key. 

After an operation such as copy, you may want to select the sending area again 
in order to clear it. This is easily clone by pressing F12 and choosing the "Reselect" 
option of the Edit Menu. Reselect establishes and locks the most recently selected 
area again. without moving the cursor bar. 

The selected area can be larger than the window. For large selected areas, you 
may prefer to position the cursor to the second corner of the rectangle by using 
the FIND key. See "Positioning the Cursor Bar and the Window" section later 
in this chapter. 

You can select the entire spreadsheet by using the "Select all" option on the 
Edit Menu. This is convenient for clearing the entire spreadsheet or changing 
the format of all current cells. 

OPERATIONS ON INDIVIDUAL CELLS 

Types of Cell Contents 

A cell can display either text, such as "Expenses," or a number, such as 123.00. 
When a number is displayed, you cannot tell whether it is a constant value 
placed in the cell directly, or a dependent value derived from a formula. 

You can check the actual contents of a cell displaying a number only by looking 
at the cell contents line while the cursor bar is positioned on the cell. 

Text 

Text consists of any printable DEC Multinational character. The horizontal tab 
character is converted to a single space character. 

When text is entered into a cell, it must be preceded by a quote character, 
either the single quote or the double quote, which is not displayed in the cell. 
If the text is terminated by a matching quote character, the terminating quote 
is also not displayed in the cell. The text may contain embedded quote characters, 
which are displayed in the cell. 
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When you enter numbers as text, be sure to use adequate labeling. Spreadsheet 
remembers that it was entered with a quote and is therefore text. But it may 
look like a number to someone using the spreadsheet. To avoid confusion when 
entering text that is purely numeric, such as a part number, you might consider 
adding parentheses, or a colon, or some character to identify it as text. 

Constant Numbers 

Numbers are signed decimal quantities. They can be entered m standanl or 
scientific notation: 

□ Standard notation includes a leading sign (optional if + ), the decimal 
digits of the integer part, a decimal point (optional if no fraction 
follows), and any fractional digits. Examples: 0, 1.23, - 5, I:357B8. 
Spreadsheet does not accept numbers that contain more than 1() 

decimal digits or 16 fractional digits. 

□ Scient(fic notation is the same as standard notation, with the addition 
of a scaling quantity. The scaling quantity consists of an E (or e), 
followed by a sign (optional if plus) and an integer exponent. The 
scaling quantity E5 is read as "times ten to the fifth power." 
Examples: 1E2, 6.023e2:3, 5.5E -8. 

Numbers are displayed in cells using standard format only. The displa~·ed number 
may contain thousands separators and a currency sign at either end. The negatiYe 
sign is displayed on the left encl. The justification setting determines where the 
number is displayed in the cell. If the number is too long to be displa~·ed in 
full, one of two things occurs. If the integer portion of the number is too long·. 
you see a number with an ellipsis ( ... ) on the right to indicate missing digits. 
If the decimal portion of the number is too long, you see a number that is 
truncated on the right. 

Options on the Format and Personalize Menu (described in Chapter 3) determine 
how the number displays. 
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Formulas 

A formula is an algebraic expression consisting of operators and operands, which 
can be evaluated into a single numeric value. There are five operators: 

I\ exponentiation 

* multiplication 

I division 

+ addition 

subtraction 

There are three operands: 

□ Constants are fixed numeric values. Example: 123. 

□ Cell references refer to other numeric cells that are used to extract 
the values in those cells. Example: B3. 

□ Functions are mathematical operations that are performed on 
specified parameters to develop a numeric value. Example: SIN(.54). 

Parentheses may be used in formulas to control the order of evaluation. Innermost 
parenthesized expressions are evaluated first. 

Expressions that lack parentheses are evaluated according to the precedence of 
their operators. Higher precedence operators are evaluated first. Adjacent op­
erators of equal precedence are evaluated in left-to-right order. Operator precedence 
is shown below; operators on the same line have the same precedence. 

highest - exponentiation 
intermediate - multiplication and division 
lowest - addition and subtraction 

Cell References 

There are two types of cell references: 

□ A named cell reference uses the cell name. Example: A9. 

□ A computed cell reference uses a special notation called a cell 
designation. A cell designation consists of square brackets enclosing 
two expressions that are separated by a comma. Example: [5:6]. 
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□ The left expression represents the number of the column of the cell 
to be referenced. The right expression represents the number of the 
row of the cell to be referenced. The cell designation [1,1] references 
the Al cell, and the cell designation [52,4] references the AZ4 cell. 

Cell references are normally written as named cell references, since that is 
sufficient in most instances. However, cell designations can be useful when 
performing more complicated operations. 

In a cell designation, the column number to the left of the comma and the row 
number to the right of the comma can be full arithmetic expressions. The expres­
sions are recomputed whenever the cell reference is made. Thus, it is possible 
to code a cell reference in a formula using the cell designator format, so that 
each time the formula is evaluated it will reference a different cell. Suppose the 
cell designation is entered as [C7,2]. This specifies that the column number part 
of the cell reference should be taken from the value of cell C7. By changing the 
number in C7, the cell designator is redirected to any cell along row 2 of the 
spreadsheet. 

Let's see how this can be used. Consider the spreadsheet shown m Figure 
2-1. 

Figure 2-1 
Using a Simple Cell Designation 
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Row 2 shows rates for fees assessed on property transfers in four states. Each 
state has been given a numeric code, which has been included in its label as a 
reminder. 

Cell C7 is used to enter the state code. Cell ClO is used to enter the selling 
price of the property. Cell C11 computes the fee assessed on the transfer. Instead 
of entering the transfer fee rate for each transaction, which is an error-prone 
action, the user of the spreadsheet can enter the state code, which can be read 
directly from the label and is a single digit. 

The transfer fee in cell Cll is computed with the formula C11 = C10*[C7 + 1,2]. 
The C7 + 1 part of the cell designation computes the correct column, based on 
the state code that is entered in cell C7. 

We can expand the table into two dimensions by adding some property classes 
and the corresponding new rates for each class in each state. See Figure 2-2. 
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A More Elaborate Cell Designation 
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By adding a property class field, CS, the user of the spreadsheet now enters 
both the state code and the property class code. The formula for Cll is changed 
to Cll = Cl0*[C7 + 1,C8 + 1]. The state code in C7 is used to compute the column, 
and the property class in CS is used to compute the row of the cell. Together, 
they supply the proper rate for the formula's evaluation. 

Functions 

A function consists of the function name, followed by the function's parameters 
enclosed in parentheses. The parameters are separated by commas. Some functions 
require a fixed number of parameters. Other functions permit an indefinite 
number of parameters, called a parameter list. 

Each parameter is an expression. The expression can be a constant such as 123, 
or a single cell reference such as C7, or a formula as defined above. 

The functions that permit a list of parameters also allow a cell range to be used 
as a parameter. For example, the SUM function can be written as 
SUM(Al,A2,A3,A4,B5) or SUM(Al:A4,B5). When a cell range is used in a 
formula, Spreadsheet just ignores cells that contain text and cells that are clear. 

Each function computes a single value. 

Function Descriptions 

ABS(parameter) 
The function computes the absolute value of the parameter. 

ATAN(parameter) 
The function computes the arc tangent of the parameter. The value is 
returned as an angle in the first or fourth quadrant, expressed in radians. 

AVERAGE(list) 
The function computes the average value of all numeric cells found in 
the list of parameters. 

C IR(parameter 1, parameter2, list) 
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CIR stands for Count In Range. The function computes the number of 
numeric cells in the list of parameters whose value lies within the numeric 
range specified by parameterl and parameter2. A number in the list 
is counted if its value is greater or equal to parameterl, and less 
than parameter2. For example, if C5 = CIR(l0,20,Al:Al00) and 
C6 = CIR(20,30,Al:A100), then any cell in the list with the value 20 is 
counted in C6, not in C5. 
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COL or COLUMN(no parameters) 
The function is equal to the column number of the cell in which the 
formula is used. A column number is equivalent to the position of the 
column letter in the alphabet. (A is 1; Z is 26; AA is 27; and AZ is 52.) 

COS(parameter) 
The function computes the trigonometric cosine of the angle given by 
the parameter. The angle must be expressed in radians. 

COUNT(list) 
The function computes the number of numeric cells in the list of parameters. 
Clear cells and cells containing text are not included in the count. 

EXP(parameter) 
The function computes the exponential function, raising e to the power 
specified by the parameter. 

FV(parameterl,parameter2,parameter3) 
The parameters represent present value (PV), number of compounding 
periods (N), and interest rate (I) for the compounding period. Assume 
you want to compute the future value of $100 in two years based on a 
12 percent annual interest rate compounded monthly. You would enter 
100 for PV, 24 for N, and 1. 0 for I. The function computes the future 
value required to satisfy the equation, FV = PV *O + I/l00rN. 

LN(parameter) 
The function computes the natural logarithm (base e) of the parameter. 
The parameter must be positive, nonzero. 

MAX(list) 
The function is equal to the highest value found in all cells of the list. 

MIN(list) 
The function is equal to the lowest value found in all cells of the list. 

PV (parameter 1, parameter2, parameter3) 
The parameters represent future value (FV), number of compounding 
periods (N), and interest rate (I) for the compounding period. Assume 
you want to accrue a future value of $500 in two years based on a 12 
percent annual interest rate compounded monthly. You would enter 500 
for FV, 24 for N, and 1.0 for I. The function computes the present value 
required to satisfy the equation, PV = FV/(1 + 1/l00rN. 

ROW(no parameters) 
The function is equal to the row number of the cell in which the formula 
is used. 

35 



CHAPTER 2 SPREADSHEET USER'S GUIDE 

SIN(parameter) 
The function computes the trigonometric sine of the angle given by the 
parameter. The angle must be expressed in radians. 

SQRT(parameter) 
The function computes the square root of the value indicated by the 
parameter. The parameter value cannot be negative. 

STD(list) 
The function computes the standard deviation of the numeric cells found 
in the list of parameters. The numeric cells are treated as a sample 
(n -1). To obtain the population standard deviation (using n, instead 
of n -1), use SQRT(V AR(list)). 

SUM(list) 
The function computes the sum of all numeric cells in the list of parameters. 

SUMSQR(list) 
The function computes the sum of the squares of all numeric cells in the 
list of parameters. 

TAN(parameter) 
The function computes the trigonometric tangent of the angle specified 
by the parameter. The angle must be expressed in radians. 

VAR(list) 
The function computes the variance of the values found in numeric cells 
of the list of parameters. The numeric cells are treated as a population 
(n). For the sample variance (using n -1, instead of n), use STD(listr2. 

Entering Cell Contents 

Entering Text 

When you enter text, you must begin with a single or double quote. If you 
forget to type a leading quote on a text value, Spreadsheet interprets the text 
as a formula and usually gives you an e1Tor. You can edit the "formula" to 
change it into text by inserting a quote character in front of it. See "Editing 
Cell Contents" below. Since Spreadsheet removes spaces from formulas, you 
might have to reinsert any spaces that you had in your text. 

Entering Numbers 

You can enter constants or formulas. When entering constants, you cannot enter 
formatting characteristics such as dollar signs and commas. Spreadsheet inserts 
these according to format settings you make on the Format and Personalize 
Menus. 
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When Spreadsheet finds an error in a formula, it provides an error message on 
the message line, puts an UNKN message in the cell, and then highlights the 
character in the formula that seems to be in error. You can simply reenter the 
entire formula if it is short. If it is long, however, you might prefer to edit it. 

Editing Cell Contents 

You can change a cell's contents by moving the cursor bar to the cell and typing 
the new contents. If you want to make a small change to a cell's contents, you 
can edit the contents instead of retyping the entire contents of the cell. 

Position the cursor bar on the cell and press the F17 key to begin to edit. 
Spreadsheet places an editing cursor in the current cell contents line. You can 
move the cursor with the ,.,_ and ~ keys, and you can delete characters to the 
left of the editing cursor with the<Zl key. Characters that you type are inserted 
ahead of the cursor. RETURN is used to finish the edit. You can cancel an edit 
before finishing by pressing CANCEL. 

Processing of Cell Contents 

As you enter data into cells, Spreadsheet performs operations on it. To use 
Spreadsheet effectively, you must understand how it processes your data. 

Automatic Evaluation 

When you enter a formula in a cell, Spreadsheet automatically evaluates it and 
displays the appropriate value. If Spreadsheet cannot evaluate it for some reason, 
it gives you an error message. For example, if the formula is incorrect or if an 
appropriate value is missing in a referenced cell, Spreadsheet places an error 
message in the cell. See "Error Messages" later in this chapter. 

As you build a spreadsheet, you create many dependent cells. When you sub­
sequently change the value of a cell, Spreadsheet automatically reevaluates all 
cells dependent on the altered cell. Spreadsheet always evaluates dependent 
values in the proper order. 

Most of your work with numbers on a sheet of paper proceeds down and to the 
right. The common expression, "bottom line," means the results of the final 
computations. 
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Spreadsheet does not determine the order of evaluation in this way, however. 
It automatically evaluates a formula whenever one of the referenced cells changes. 
This causes the result cell to change. If there is another formula dependent on 
that cell, that formula is reevaluated, and so on. 

This process is independent of direction, so it is possible to reference a cell that 
appears at the bottom of one column in a formula at the top of another column. 
The formula can even reference cells in columns to the right of the cell that 
contains the formula. 

This is a useful feature of Spreadsheet. For example, you can develop a set of 
detailed computations and results in an area of the spreadsheet that you seldom 
view in the window, perhaps off to the right side. The results developed in that 
area can be retrieved for display and additional computation in a summary section 
on the left side of the spreadsheet, where you do most of your work. You are 
not bound by any right-to-left or top-to-bottom ordering when you establish 
these work areas. 

Turning Off Automatic Evaluation 

Entering new data into a large spreadsheet can be slow if there are many 
formulas to be evaluated on each new value. You can turn off this automatic 
evaluation while the new values are entered and then turn it back on to see the 
results of all formula evaluations. You turn automatic evaluation off and on by 
choosing "Options" on the Personalize Menu. 

While this is a very useful feature of Spreadsheet, it is also dangerous. If you 
forget to turn on the evaluation when you are through entering new numbers, 
you may look at dependent cells and be misled into thinking that they have been 
reevaluated. 

Chains of Computations 

When dependent cells reference other dependent cells, you have a chain of 
computations. Spreadsheet will evaluate automatically a chain with fewer than 
62 cells in it. However, you have to perform some extra steps before Spreadsheet 
will evaluate a chain longer than 62 cells. 

When you create a dependent cell in a chain longer than 62 cells, Spreadsheet 
inserts an UNKN error message into the cell. It also gives you a warning message 
that your chain of computations is too long. If this happens, do one of the 
follov.ring: 
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□ Delete the dependent cell you just entered and begin a new chain of 
computations. 

□ Delete a dependent cell earlier in the chain and enter a constant in 
its place. This breaks your chain into segments. 

□ If you have only a few more cells to add to the chain, continue to 
create cells until the chain is complete. (If you have many more cells 
to add, this method is undesirable because you receive Spreadsheet's 
warning message each time you add a cell.) Then return to the first 
cell in the chain (the cell on which the entire chain depends) and 
reenter its data. Spreadsheet deletes the UNKN error messages and 
automatically evaluates all the cells in the chain. 

□ If you have many more cells to add to the chain, turn off automatic 
evaluation (see the previous section, "Turning Off Automatic 
Evaluation") before creating your new cells. When your chain is 
complete, return to the first cell in the chain. Turn automatic 
evaluation back on. Then reenter the first cell's data. Spreadsheet 
deletes the UNKN error messages and automatically evaluates all the 
cells in the chain. 

Error Messages 

Spreadsheet generates several types of error messages. Some of these occur on 
the cell contents line. For example, if you are typing in a formula and leave it 
incomplete, Spreadsheet might display a prompt "Expecting a value." 

Sometimes Spreadsheet is unable to complete an operation you have requested. 
When this happens, Spreadsheet gives you an error message. Press HELP or 
consult this manual to learn how to correct the error condition. 

Spreadsheet also inserts warning messages into spreadsheet cells. There are 
four types of warning messages: · 

□ PEND. This indicates that Spreadsheet did not find a value in a 
referenced cell. For example, if Spreadsheet finds a clear cell where 
it expected a number, it displays a PEND error message.· 

□ UNKN. This can mean that Spreadsheet did not find the correct kind 
of value in the referenced cell. For example, if it finds text in the 
cell, Spreadsheet displays an UNKN message. UNKN can also mean 
that there are too many dependent cells in a chain of computations. 
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□ CIRC. This indicates that Spreadsheet found a circle of dependencies. 
This indicates a flaw in the dependent relationships among cells. 
Usually a CIRC message also causes some UNK.Ns, as formulas find 
the text CIRC where they expected to find a number. 

□ EVAL. This indicates that Spreadsheet detected an invalid parameter 
in an arithmetic expression. Besides displaying EVAL in the cell, 
Spreadsheet describes the error in the cell contents line. Errors that 
cause EVAL to appear include attempting to divide by zero and 
attempting to raise a negative number to a nonintegral power. 

Spreadsheet's error messages are designed to help you locate and correct the 
problem. 

Controlling the Cell's Appearance 

Each cell in the spreadsheet has a number of formatting characteristics that 
determine its appearance in the window or in a report. Spreadsheet provides 
certain default characteristics that you can change from menus. Some of the 
formatting characteristics control all entries in the spreadsheet; others control 
only certain types of cells or cells within a selected range. Basically, you can 
control the following: 

□ New cell format 

□ Current cell format 

□ National symbols 

□ Column width 

New Cell Format 

When you start up Spreadsheet and begin to create a new spreadsheet, all cells 
are clear. When a clear cell is used as a new cell, it is given formatting characteristics 
known as new cell formatting characteristics. Because these characteristics are 
given to every new cell, you should make sure the settings are appropriate for 
most of your entries. Think about the type of data you plan to enter and how 
you want it to display before you begin. 

The formatting characteristics and the default values are listed below: 

□ Decimal places: 0.00 

□ Currency: Off 
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□ Thousands: Off 

□ Numbers: Right-justified 

□ Text: Extended 

□ Rendition: Normal 

These options are described in detail in Chapter 3 under the Format Menu. 

You can change the default characteristics by using the "New cells" option on 
the Format Menu. Change the characteristics to suit the majority of your entries. 
Then change individual cells or groups of cells as needed with the "Cells" option 
explained in the "Cell Format" section later in this chapter. 

You can change the new cell formatting characteristics at any time. Changes 
do not alter the formats of existing cells, but control the format of any clear 
cells when they are put into use. 

Cell Format 

The cell for-mat refers to the format of cells already in use. The formatting 
characteristics and default settings are identical to those listed under the new 
cell format. You change the cell format by using the "Cell" option on the Format 
Menu. 

You can use the "Cell" option to change the format of an individual cell (the 
default) or a selected area of cells when you need a cell format that differs from 
the new cell format. Or if you change your mind about your cell format after 
you have made entries in the spreadsheet, you can select the entire spreadsheet 
and change the format of all cells in use. If you do this, be sure to change your 
new cell format as well, so that new cells will have the same format as the cells 
muse. 

National Symbols 

Because countries have different ways of displaying numbers, especially currency, 
Spreadsheet allows you to specify National Symbols formatting characteristics. 
You use the "National" option on the Personalize Menu to specify the characteristics. 
The options and their default values are as follows: 

□ Currency symbol: $ 

□ Justification: Left 
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□ Decimal symbol: Period 

□ Thousands separator: Comma 

The settings you make on the National Symbols Menu control the way numbers 
display on the entire spreadsheet. When you change these settings, you reformat 
all cells currently in use, and you control the format of any new cells. The 
settings you make affect any new spreadsheet as well. 

Column Width 

The width of spreadsheet cells is determined by the column width. The default 
width is 11 characters. If you want to change it, use the "Column width" option 
on the Format Menu. You can allow text to extend into an adjacent clear cell, 
if you choose the "Extended" setting for text on the cell format menus. 

OPERATIONS ON THE SPREADSHEET 

Positioning the Cursor Bar and the Window 

The cursor bar identifies the current cell. In order to affect the contents of a 
cell, you must move the cursor bar to that cell. 

You can move the cursor bar within the window by using the ARROW keys. 
When the cursor bar reaches a cell on the edge of the window, continued 
movement in that direction causes the spreadsheet to scroll through the window 
one row or column at a time. 

You can move the cursor bar up or down on the spreadsheet in larger increments 
by using the NEXT SCREEN and PREV SCREEN keys. These keys move the 
cursor bar up (PREV SCREEN) and down (NEXT SCREEN) by a number of 
rows equal to the rows displayed in the current window. If the current window 
shows 12 rows, the cursor bar moves by 12 rows with each press of the NEXT 
SCREEN or PREV SCREEN keys. 

You can move the cursor bar directly to a known cell by using the FIND key. 
When you press the FIND key, the current cell contents line shows the "Find" 
prompt. Enter the name of the desired cell and press RETURN. The window 
moves directly to that area of the spreadsheet and the cursor bar is placed on 
that cell. 
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Inserting is the process of adding a whole row or column of new cells between 
existing columns or rows. An inserted row or column pushes existing rows or 
columns downward or to the right, causing them to be renumbered. You insert 
rows or columns by choosing the "Insert" option on the Edit Menu. See the 
description of the "Insert" option in Chapter 3 for details on how formulas are 
adjusted after an insert operation. 

Removing 

Removing is a process of deleting a whole row or column of cells between existing 
columns or rows. Rows or columns that are below or to the right of the removed 
row move into the space and are renumbered. You remove rows or columns by 
choosing the "Remove" option on the Edit Menu. See the description of the 
"Remove" option in Chapter 3 for details on how formulas are adjusted after a 
remove operation. 

Copying 

Copying is a process of moving a selected area to a new location on the spreadsheet. 
(The selected area may be a single cell, of course.) All cells in the selected 
(sending) area are moved to the receiving area. The cell contents and formats 
are moved. You copy an area by choosing the "Copy" option on the Edit Menu. 
See the description of the "Copy" option in Chapter 3 for details on how formulas 
are adjusted after a remove operation. 

Setting Spreadsheet Areas to a Common Value 

Replicating 

Replicating is the process of inserting the same cell contents and formats into 
every cell of a selected area of the spreadsheet. You perform this operation by 
choosing the "Replicate" option on the Edit Menu. 

Clearing 

Clearing is the process of removing both cell contents and formats from a cell. 
Clearing releases the memory space previously used to store the cell contents 
and formats. You perform clearing by choosing the "Clear cells" option on the 
Edit Menu. 
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Blanking 

Blanking is the process of removing cell contents but not cell formats. You 
perform blanking by choosing the "Blank cells" option on the Edit Menu. 

Reading in New Data 

When you begin to use Spreadsheet, you can either create a new spreadsheet 
by typing in cell contents or you can work with an existing spreadsheet by 
loading it. Once you begin to work with a spreadsheet, new or existing, you 
can bring new data into the spreadsheet in several ways. 

Reading Table Files 

Data from other Synergy applications can be written to the clipboard, a temporary 
holding area. It is stored in a table file format that is described in the Window 
Manager User's Guide. Spreadsheet can read data from the stored table file 
into cells. Use the "Read from clipboard" option on the File Menu. 

Reading Generic Data 

Spreadsheet can read generic data from the clipboard or from a file. Generic 
data is data from another application that is not in table file format. 

The generic data must be a standard ASCII text file. A carriage return indicates 
the end of a record. Generic data records can contain text, numbers, and nulls. 
Items must be separated by spaces, tabs, or commas. 

Spreadsheet reads the first item in the first record into the current cell. It 
continues to fill cells in that row until it reads a carriage return character or 
reaches the end of that record. It then reads data from the next record into 
the next row, starting from the same column as in the first row. For example, 
if you began reading in the first record in column 5, Graph reads in each subsequent 
record beginning with column 5. If Spreadsheet reaches the end of a row before 
the end of the record, it reads the remaining items in the record into the next 
row, again beginning with the same column. 

If you want each record to fit in one row, be sure to begin reading in the data 
in a column far enough to the left. Also make sure the spreadsheet has enough 
remaining rows to contain all the data. 

Spreadsheet can read generic data from the clipboard. For example, using 
PRO/Communications you could copy a file from a host to the clipboard, then 
read it into Spreadsheet by using the "Read from clipboard" option. 
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Spreadsheet can also read generic data from a file. Once you specify the file, 
Spreadsheet reads the data into successive cells. Use the "Get data from file" 
option to read data from a file into Spreadsheet. 

Moving Data out of the Spreadsheet 

The contents and formats of all cells of the spreadsheet can be saved for use at 
another time. The displayed values of the spreadsheet can also be extracted and 
saved for use in other ways, for example: 

□ Reports - The data can be formatted as a document file so that the 
file can be merged with other documents, edited and printed. 

□ Tables - The data can be formatted as a table for use in other 
applications such as Graph or Datamanager. 

Saving the Spreadsheet 

When you save the spreadsheet, you write all cell contents and cell formatting 
information (including new cell formats and the national symbols) to a file. When 
you reload the spreadsheet, the saved contents and formatting information replace 
the current settings. 

Besides saving the formatting information of a particular spreadsheet in a file, 
Spreadsheet also saves the values last chosen for the following: 

□ National symbols 

□ Window size 

□ Report width 

□ Memory size 

When you create a new spreadsheet, these saved values are loaded. 

For example, if you always create spreadsheets with the same national symbols 
you can set these once, and never again be concerned with them. If you occasionally 
change the settings, however, you should check them each time you begin to 
create a new spreadsheet. 

Reporting 

A report is a document file with the row and column arrangement of the spreadsheet 
preserved so that the file can be printed to look like the spreadsheet's window. 
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As a document, the file can be edited with PROSE PL US and combined with 
other documents. 

A report can include all used cells of the spreadsheet, or it can be restricted to / , 
a selected area. If a selected area is to be reported, you must select the area 
before beginning the reporting operation. A selected area includes only contiguous 
cells. 

You can also format your report to include only certain noncontiguous rows and 
columns. You must include only whole rows and columns. This option provides 
great flexibility in reporting. 

Reporting is initiated from the "Report" option on the File Menu. 

Writing to the Clipboard 

When Spreadsheet writes to the clipboard, it places both a table and a report 
on the clipboard. A table is a grid of rows and columns that corresponds to the 
rows and columns in Spreadsheet. Graph and Datamanager can use the table 
information. PROSE PL US can use the report information. 

As with a report, you can write the entire spreadsheet, a selected area, or 
noncontiguous rows and columns that you specify. 

Memory Usage 

A spreadsheet occupies space in the Professional's memory. Clear cells do not 
require space, so the amount of memory space used by any spreadsheet depends 
on the number of cells that are in use, and on the contents of the cells. A 
spreadsheet that uses a large number of cells can run out of memory space. 

A memory size of 32KB is the default value and is adequate for many spreadsheets. 
You can consult the Spreadsheet Status window at any time to determine how 
many cells you have used and what percentage of the available memory is in 
use. When you see that the amount of memory use exceeds 90 percent, you 
should consider increasing the memory available to Spreadsheet; see the "Per­
sonalize Menu" section in Chapter 3. 

Spreadsheet Status 

The Spreadsheet Status window shows the file name of the spreadsheet file (if 
any), the maximum memory available, the percentage of memory that has been 
used, and the number of cells that have been used. You view the Spreadsheet 
Status window by choosing the "Status" option on the File Menu. 
46 
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Chapter 3 

Using the Application 
Once you have created a spreadsheet, you perform most operations on it through 
Spreadsheet menus. This chapter describes how to use each menu option. 

The Main Menu has four hanging menus: File, Edit, Personalize, and Format. 
The keys labeled F11 through ADDTNL OPTIONS correspond to Spreadsheet's 
four menus (see Figure 3-1). 

Addtnl 

(DrDriirtff 
i t i t 

File Edit Per- Format 

Figure 3-1 
Menu Keys 

sonalize · 

When you press a menu key, Spreadsheet displays the associated hanging menu. 
You select an item from the hanging menu by using t or ! to move the cursor 
bar onto the option. 

49 



CHAPTER 3 ; SPREADSHEET USER'S GUIDE 

FILE MENU 

The File Menu lets you control movement of data to and from the spreadsheet. 

R1port 
Craph 
Status 

R11d frOl!I clipboard 
Writ, to clipboard 

Cit data fr0111 fil1 

S1v1 1pr11d1h1et 
Load 1pr11d1h11t 

I 

Exp1n1n 
123.00T1l1phon1 
◄!56.00Travtl 
788.00Lod9in9 

MU!iiftm:(total l 

01pt A: 
0.pt B1 

246.06 
1120.94 

ept A(cp~l01pt B(cp~l 

Figure 3-2 
File Menu 

• 246,06 1120.94 

Press F11 to see the File Menu. Select an option and press DO, or press EXIT 
to leave the menu. 

Report 

Choose the "Report" option to save your spreadsheet data as a document file, 
with the default extension .DOC. With PROSE PLUS, you can edit your report 
and merge it into other documents. 

The report preserves the row and column arrangement of the spreadsheet, so 
that it looks like the spreadsheet window. 

You can choose to report the entire spreadsheet, a selected portion of it, or 
noncontiguous areas of your choice. If you wish to report a selected portion, 
you must select the area before choosing "Report" on the File Menu. 
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If you do not select an area, Spreadsheet displays a form giving you the option 
of reporting the entire spreadsheet or designated rows and columns. You can 
only choose entire rows and columns, not portions of them. If you choose rows 
and columns, Spreadsheet displays the following form. 

Figure 3-3 

Expenus 
123. OOTe le phone 
4!iS.OOTr-avel 
788.00Lodging 

MH@MQ:(total) 

Dept A: 
Dept B: Which columns and rows do BOU 

want to includ1 in the r-1port? 
ept A!cpBlDept B!cpBl 

1

1 Column .. •, 
24S.OS 1120,94 • =---------- Rows: 

Pl"fll EXIT to accept valUH, 

Report Rows and Columns Form 

Use the <xJ key and enter the rows you want. You can indicate a range of 
rows, as in 1:5, individual rows, as in 7, or a combination of the two as in 1:5, 
7, 9:11. Be sure to insert commas between your choices. When you are finished 
specifying the rows you want in your report, move the cursor to columns by 
pressing RETURN. Enter the columns you want reported in the same way. 
Press EXIT to accept the displayed values. Spreadsheet reports the rows and 
columns you have chosen. 

A report can be wider than 80 characters and thus might not fit on an 80-
character wide printout. When a report is too wide to be printed in 80-character 
wide format, you have two options. You can print it in 132-character wide format 
by choosing "Report width" under "Options" on the Personalize Menu. Or you 
can let Spreadsheet format it into vertical strips that are approximately 80 (or 
132) characters wide. Each strip starts on a new page. When the report is 
printed, the strips can be separated a11d placed side by side to make the desired 
width. See Figure 3-4. 
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Department A, summary of Travel Expenses for first six months of 1984 

Air/Rail, etc 
Personal auto 

Rental auto 

Lodging: 
Heals 

Telephone, etc.: 
Miscellaneous: 

Totals: 

Air/Rail, etc 
Personal auto 

Rental auto 

January February March April May +----------+----------+----------+----------+----------421.65 0.00 1,211.80 8,214.00 0.00 
40.41 37.60 37.12 51.72 56.70 
85.21 0.00 218.28 602.21 0.00 

0.00 
35.25 

10.25 
0.00 

0.00 
33.27 

0.00 
0.00 

407.50 
145.45 

24.20 
22.00 

2,188.18 
881.47 

114.20 
99.00 

0.00 
31.15 

0.00 
0.00 

+----------+----------+----------+----------+----------
592.77 70.87 2,066.35 12,150.78 87.85 

June Totals +----------+----------
0.00 9,847.45 

68.25 291.80 
0.00 905.70 

74.20 
64.50 

20.40 
0.00 

2,669.88 
1,191.09 

169.05 
121.00 

+----------+----------
227.35 15,195.97 

Department A, Summary of Travel Expenses for first six months of 1984 

January February March April May June Totals 
+----------+----------+----------+----------+----------+----------+----------421.65 0.00 1,211.80 8,214.00 0.00 0.00 9 847.45 

40.41 37.60 37.12 51.72 56.70 68 25 '291 8( 
85.21 0.00 218.28 602.21 0.00 o:oo 905:70 

0.00 0.00 407.50 2,188.18 0.00 74.20 2 669 88 Lodging: 
Heals 35.25 33.27 145.45 881.47 31.15 64.50 1:191:09 

Telephone, etc.: 
Miscellaneous: 

100.2005 0.00 24.20 114.20 0.00 20.40 169.0: 
. 0.00 22.00 99.00 0.00 0.00 121.00 

+----------+----------+----------+----------+----------+----------+----------
Totals: 592.77 70.87 2,066.35 12,150.78 87.85 227.35 15,195.97 

Figure 3-4 
Printing a Wide Spreadsheet 
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You can print the report using Synergy File Services or P/OS menus. In either 
case, choose the .DOC (or DOCUMENT) file created by the "Report" option, 
not the . WRK file. See your Hard Disk System User's Guide for instructions 
on printing files from P/OS menus. 

Graph 

Choose this option when you want to send data from Spreadsheet to Graph 
without using the clipboard. You can choose to send Graph the entire spreadsheet, 
a selected area, or whatever noncontiguous rows and columns you specify. 

If you have a large spreadsheet, however, you cannot graph all of it at once; 
you are limited to the 30 rows and 10 columns in Graph's data window. If you 
send 40 rows and 20 columns of Spreadsheet data to Graph, for instance, Graph 
places the first 30 rows and the first 10 columns in the data window and then 
graphs them. The remaining 10 rows and 10 columns are not graphed because 
they do not fit in the data window. If you have a large spreadsheet, therefore, 
divide it into portions and graph the portions individually. 

When you choose the "Graph" option, Spreadsheet is suspended and Graph is 
automaticall~r started. The Spreadsheet data is copied to the data window in 
Graph. When you see the data, you can choose graph type and setup options 
and draw a graph. (Refer to the Graph Use1·'s Guide for details.) When you 
exit Graph. you return to the current cell in Spreadsheet. 

Status 

You can check on the status of the spreadsheet at any time by choosing the 
"Status" option of the File Menu. Spreadsheet displays the Spreadsheet Status 
window showing the file name of the spreadsheet file (if any), the maximum 
memory available, the percentage of memory that has been used, and the number 
of cells that have been used. If you see that you are approaching the upper 
limits of available memory, you can increase it. See the Personalize Menu section 
of this chapter for instructions on changing memory size. 

Read from Clipboard 

Choose this option when you want to move data from the clipboard to your 
spreadsheet. Before you choose this option, however, you must determine where 
in the spreadsheet you want the data to go. 

Spreadsheet can read two types of data from the clipboard: table files and generic 
data. Spreadsheet always looks first for a table (.TAB) file. If it does not find 
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one, it looks for a document (.DOC) file. Since the clipboard stores only one file 
at a time, you must make sure that the file you want to read into Spreadsheet 
is the one most recently written to the clipboard. 

Graph and Datamanager write data to the clipboard in the form of table files. 
For example, suppose that you are maintaining a database of expense reports 
and you can extract expense information from the database and write it to the 
clipboard using Datamanager. The information is stored in the clipboard's table 
file (described in Window Manager User's Guide). You must know the format 
(number of rows and columns) of the data stored in the clipboard's table file so 
that you can place it properly within your spreadsheet. 

When information is read from the clipboard's table file, it is placed in a rectangular 
area of the spreadsheet equal in size to the number of columns and rows found 
in the clipboard's table file. The location of this rectangle is determined by the 
position of the cursor bar when the clipboard read is initiated. 

To place the clipboard data in the proper place, move the cursor bar to the 
upper left corner of the rectangular area that is to receive the clipboard's table 
file. Then choose "Read from clipboard" and press DO. 

The values in the clipboard's table file replace the cell contents in the rectangular 
area. All cells that are used take on the new cell formatting characteristics. 
Dependent values are then recomputed. 

Spreadsheet can also read generic data from the clipboard. For example, using 
PRO/Communications you can copy any ASCII text file from a host to the 
clipboard. When you choose "Read from clipboard," Spreadsheet reads in the 
file as generic data (as described in Chapter 2) starting with the current cell. 

Write to Clipboard 

Choose this option when you want to write data from Spreadsheet to the clipboard. 

Just as with the "Report" option, you can write the entire spreadsheet, a selected 
portion, or noncontiguous rows and columns that you specify. 

If you want to write a selected area, you must perform the selection prior to 
choosing the "Write to clipboard" option. 

If you have not selected an area, Spreadsheet displays a form giving you the 
option of writing the entire spreadsheet or rows and columns of your choice. 
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Use the form and specify the rows and columns as described under the "Report" 
option. Choose "Write to clipboard" when you are ready to initiate the operation. 

When Spreadsheet writes to the clipboard, it places both a table and a report 
on the clipboard. Table information can be used in Graph and Datamanager; 
report information can be used in PROSE PL US. The report that is written to 
the clipboard is identical to the report produced by the "Report" option. 

Information that is written to the clipboard, whether in table or report form, 
contains only the displayed value of the cells. Formulas and formatting information 
are not transferred to the clipboard. If the clipboard information is read back 
into the spreadsheet, the data comes in as constants and takes the new cell 
formatting characteristics. 

Get Data From File 

Use this option to read generic data from a file into Spreadsheet. The file can 
be any ASCII text file. Chapter 2 describes generic data format and how Spread­
sheet reads the data into cells. 

When you choose this option, Spreadsheet displays the files contained in your 
current directory. If the file you want to read into Spreadsheet is in another 
directory, press ADDTNL OPTIONS to display your other directories. Choose 
another directory, then choose the file you want to read into Spreadsheet. You 
can also use the FIND key and directly enter the directory and file name you 
want to read into Spreadsheet. 

Spreadsheet begins reading the data from the file into the current cell. 

Save Spreadsheet 

Choose this option when you want to save the spreadsheet in a file. 

Spreadsheet asks if you want to supply a new file name. If you do not change 
the name, a new version of the current spreadsheet file is created automatically. 
Spreadsheet files use . WRK as the file type by default. 

When you save a spreadsheet using the "Save spreadsheet" option on the File 
Menu, everything except the window size and the window placement on the 
screen is saved with the spreadsheet file. All formatting information (including 
new cell formats and the national symbols) is saved in the file. When you load 
the file again using the "Load spreadsheet" option of the File Menu, the saved 
formatting information replaces the current settings. Thus, the new cell formats 
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and the national symbols for a given spreadsheet do not change, unless you 
explicitly change them. 

Load Spreadsheet 

Choose this option when you want to load an existing spreadsheet or create a 
new one. (This step occurs automatically when you start up Spreadsheet.) 

Spreadsheet displays a file selection menu, showing files in the current directory 
that have the . WRK file type. You can choose one of the files or alter the file 
specification to make another choice. Choose the spreadsheet file you want to 
load. 

Spreadsheet loading is preceded by automatic clearing of the entire spreadsheet 
window so that cell contents and formats of the previous spreadsheet are removed. 

· All cell contents and formats are thus established by the spreadsheet being 
loaded. 

EDIT MENU 

The Edit Menu gives you options for editing the contents of cells and reproducing 
the content. Figure 3-5 shows the Edit Menu. 

Figure 3-5 
Edit Menu 
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Reselect 

Choose "Reselect" when you want to perform a second operation on a cell or 
group of cell previously selected. Selecting is explained in Chapter 2. 

This option is useful for such things as clearing an area after you have copied 
data to a new area of the spreadsheet. After you have completed the Copy 
operation, choose "Reselect." This establishes and locks the most recently selected 
area again, without moving the cursor bar. Then choose the "Clear cells" option 
explained below. 

Select All 

Use this option to select all cells in the spreadsheet prior to performing an 
operation. For example, you might select all cells if you wanted to clear the 
entire spreadsheet or change the cell format of all cells currently in use. 

Insert 

Choose this option when you want to insert an entire new row or column between 
existing rows or columns. You determine the location of the row or column by 
placing the cursor bar in any cell of the existing row or column, where you want 
the new row or column to be inserted. 

You can initiate the insert operation by choosing "Insert" from the Edit Menu 
or by using the INSERT HERE key. Spreadsheet displays a menu, and you select 
either the "Row" or "Column" option and press DO. 

Spreadsheet inserts a new column or row, and pushes existing rows or columns 
downward or to the right, causing them to be renumbered. 

All formulas in the spreadsheet are adjusted as follows: 

□ Named references to any cell that has been moved by the insertion 
are adjusted to point to the cell's new location. 

□ Since the rightmost column or the lowest row is lost by the insertion, 
any named references to lost cells are adjusted to point to the 
corresponding cell in the new column or row. 

Remove 

Use this option to remove a whole row or column of cells between existing 
columns or rows. You designate which row or column to remove by moving the 
cursor bar to any cell in that row or column before you choose "Remove." 
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Initiate the remove operation by choosing "Remove" from the Edit Menu or by 
using the REMOVE key. Spreadsheet displays a menu and you select either the 
"Row" or "Column" option and press DO. Spreadsheet removes the row or 
column you designated. Rows or columns that are below or to the right of the 
removed row or column move into the space and are renumbered. 

All formulas in the spreadsheet are adjusted as follows: 

□ Named references to any cell that has been moved by the removal 
are adjusted to point to the cell's new location. 

□ The removed column or row is cleared and moved to the extreme 
right or bottom of the spreadsheet. Any references to a removed cell 
are adjusted to point to the corresponding cell in its new position. 

Copy 

Use this option when you want to move a selected area to a new location on 
the spreadsheet. Perform the copy operation in three steps: 

1. Select the area (as described in Chapter 2) that you want to copy 
(the sending area). 

2. Designate the receiving area by moving the cursor bar to the cell 
representing the upper left-hand corner of the rectangle where you 
want the data to be copied. 

3. Select "Copy" from the Edit Menu, and press DO to begin the copy 
operation. 

All cells in the selected (sending) area are moved to the receiving area. 

The cell contents and formats are moved. For example, clear cells in the sending 
area produce clear cells in the corresponding cells of the receiving area. 

The previous contents and formats of the receiving area are lost during the copy 
operation. If the receiving cells were referenced by formulas in other cells, error 
messages may appear in the referencing cells. 

Formulas in the sending area cells are copied to the rece1vmg area. These 
formulas are adjusted as follows before being placed in the receiving area: 
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line for cell XI shows Xl = A3 + B7, and cell XI is moved down by 
one row to cell X2, its formula is altered so that the new contents 
line shows X2 = A4 + BS. That is, the row numbers are increased by 
one. If the same XI cell is moved two cells to the right as well as 
down one cell (to Z2), the new formula is Z2 = C4 + D8. That is, the 
row numbers are increased by one, and the column letters are 
increased by two. 

□ The "@" character can be used to protect a named reference against 
any adjustment during a copy (or replicate). If a named reference is 
preceded by "@".in the formula, the reference is not adjusted at all 
when the formula is copied. For example, if the XI cell described 
above contained the formula XI= A3 + @B7 and it was moved from 
XI to Z2, the Z2 cell would then have the formula Z2 = C4 +@B7. 
That is, the unprotected reference A3 is adjusted, but the protected 
reference @B7 is not adjusted. 

Notice that formulas are adjusted only in the cells that are moved by the copy 
operation. Formulas are not adjusted in the rest of the spreadsheet. 

Replicate 

Use this option to insert the same cell contents and formats into every cell of 
a selected area of the spreadsheet. 

Perform a replication in three steps as follows: 

1. Select (as described in Chapter 2) the area which is to receive the 
replicated values. 

2. Move the cursor bar to the cell which is to be replicated. 

3. Select "Replicate" from the Edit Menu, and press DO to complete the 
replication. 

Notice that replicating an area with a clear cell is equivalent to clearing the 
area. However, replicating an area with a blank cell (a cell that has some 
formatting characteristics) puts the formatting characteristics into all cells, changing 
them to blank cells. If you intend to clear an area, it is best to use the "Clear 
cells" operation. 
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If the cell being replicated has a formula, any named references are adjusted 
before being placed in each receiving cell. The replication can be thought of as 
a set of single cell copies. For example, suppose the cell A12 holds the formula 
A12 = SUM(Al:A10)*@A20, and you replicate it into cells B12, C12 and D12. 
The named references that are not protected by the @ character are adjusted, 
so that these cells then read: 

812 = SUM(81 :81 O)*C<i A20 

C12 = SUM(C1 :C1 O)*C<:i A20 

D12 = SUM(D1 :D1 O)*@ A20 

The formula in cell A12 is not changed. 

Clear Cells 

Use this option to free cells from use. Both the cell values and the cell formats 
are removed. The space required by the cells is released by the clear operation. 

Clearing always operates on a selected area. If there is no selected area, the 
current cell is taken as the selected area. If you want to clear an area, you 
must select it (as described in Chapter 2) before choosing "Clear cells." 

Clearing is initiated when you choose "Clear cells" from the Edit Menu. 

To clear all cells of the spreadsheet, first choose "Select all" on the Edit Menu. 
Then choose "Clear cells" on the Edit Menu. 

The cell contents line for a clear cell shows that the cell holds no value. For 
example, A3 =. 

Blank Cells 

Use this option to remove cell contents without altering the cell formats. The 
displayed values in the cells are removed, but the cell formats are unchanged. 
Clear cells in the area being blanked are not changed. Some space is released 
by a "Blank cells" operation, but since the cell formats are retained, blanking 
a cell does not free as much space as clearing the same cell. "' 

_) 
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Blanking always operates on a selected area. If there is no selected area, the 
current cell is taken as the selected area. If you want to blank an area, you 
must first select it (as described in Chapter 2). Blanking is initiated when you 
choose "Blank cells" from the Edit Menu. 

The current contents line for a blank cell shows that the cell holds text of zero 
length. For example, A3 = ". 

PERSONALIZE MENU 

' 
This menu contains options that control Spreadsheet operation and number 
formatting. Pressing F13 causes the Personalize Menu to appear. 

Figure 3-6 
Personalize Menu 
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Options 

Choosing this entry causes Spreadsheet to display a menu with the options 
shown in Figure 3-7. 

Figure 3-7 
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Options Setup Menu 

Evaluation 

Normally when you enter data into Spreadsheet, it is automatically evaluated. 
The "Evaluation" option of the Spreadsheet Options Menu permits you to turn 
off automatic evaluation. The two possible settings are AUTOMATIC and OFF. 

Report Width 

This option enables you to specify the width of the report. The default value is 
80 columns per line. You can change it to 132 columns by moving the cursor 
bar to "Report width" and pressing DO. 
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Maximum Size 

This option allows you to specify the maximum memory size of the spreadsheet. 
When you choose this option, a list of the available memory space size options 
displays. All sizes are in kilobytes (KB). The options are as follows: 32KB, 64KB, 
96KB, or 128KB of memory. 1 A very rough guideline is that 32KB of memory 
holds approximately 1,000 cells in use. 

To check the memory used, do the following: 

1. Press F11 to get the File Menu, and choose "Status" to see the 
Spreadsheet Status window. The "Spreadsheet Memory," "Memory 
used," and "Cells used" entries show you the needed information. 

2. Press EXIT to remove the Spreadsheet Status window. 

To increase the memory available to Spreadsheet, you must specify the new 
memory size, then exit from Spreadsheet and restart it in order to have Spreadsheet 
use the additional memory. If you are already working with a spreadsheet, this 
will require that you save the current spreadsheet and then reload it when you 
restart Spreadsheet. The steps are as follows: 

1. Press F13 to get the Personalize Menu, then choose "Options" to see 
the Spreadsheet Options Menu. 

2. Position the cursor bar on "Maximum size" and press DO to see the 
four possible maximum memory choices. 

3. Select the memory size that is the next larger to the value currently 
in use, and press DO. 

4. Press EXIT to accept the new value. 

5. Press EXIT again to leave Spreadsheet. Spreadsheet asks if you want 
to save the Spreadsheet. Choose "Save." 

6. Select Spreadsheet again from the Synergy Main Menu. When the file 
selection menu appears during start-up, choose the file that you just 
saved. 

1 96KB and 128KB memory space options for Spreadsheet require the installation of either a 256KB 
or 512KB memory board, in addition to the 512KB of memory that is standard on the Professional. 
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7. After the spreadsheet has been reloaded, recheck Spreadsheet Status 
to ensure that Spreadsheet is now using a larger maximum memory 
size. The "Memory used" entry should show a lower percentage. 

The maximum memory size is stored with the Spreadsheet application, not with 
the individual spreadsheet data files. Thus, when you increase the Spreadsheet's 
maximum memory size, Spreadsheet continues to use the larger memory size 
for all spreadsheets. 

Loading a small spreadsheet into the larger memory space can slow Spreadsheet's 
performance. The larger values of maximum memory should be used only for 
large spreadsheets that must have the increased memory space. 

If you have used this option to reduce memory size, you might encounter a 
problem when you try to load a large spreadsheet. In this case, Spreadsheet 
loads part of the spreadsheet, then tells you it could not complete the operation. 
Assuming you want to load the entire Spreadsheet, you should increase the 
memory size and exit from Spreadsheet. When exiting, do not save the partial 
spreadsheet, as it would supersede the complete original one. Then start Spread­
sheet again, and load the spreadsheet. 

National 

Use this option to specify how numbers and currency are displayed. Spreadsheet 
assumes by default that you want the dollar sign as the currency symbol and 
that the currency symbol is to be left-justified on the number. Like wise, Spread­
sheet also assumes that the decimal point should be a period and the thousands 
separator should be a comma. 

Use the "National" option to tailor Spreadsheet to meet your needs. For example, 
if you want to represent Australian dollars, you might want to display the 
currency symbol as $A. If you want to show francs, you might display Fr on 
the right end of the number. You can change the decimal point to a comma, or 
the thousands separator to a space, as is common in some European countries. 

When you choose "National," the National Symbols Menu appears. 
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Figure 3-8 
National Symbols Menu 
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The National Symbols Menu offers four options: 

□ Currency symbol: The symbol can be up to four characters in length. 
Leading or trailing spaces may be supplied so that you can guarantee 
separation from the number. 

□ Justification: The currency symbol may be appended to the left or 
right end of the number. 

□ Decimal symbol: The decimal point may be changed to another 
character. Any character, including the comma or space, is allowed. 

□ Thousands separator: The character used to punctuate the number 
at every third digit to the left of the decimal point can be changed. 
Any character, including the space, is allowed. 

The number formats you specify on this menu apply to the entire spreadsheet, 
not just current or new cells, as on the Format Menu described below. For 
example, you can use options on the Format Menu to display various numbers 
of decimal places throughout the spreadsheet, but the currency symbol you 
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choose from the National Symbols Menu 1s the only one displayed m the 
spreadsheet. 

If you create a spreadsheet on which you want to show two or more currency 
symbols, you may be able to place the least used currency symbols in cells 
adjacent to the number cells by entering the currency symbol as text and turning 
off the "Currency" characteristic on the number cell itself. 

The settings you make on the National Symbols Menu remain in force for all 
new spreadsheets as well. 

FORMAT MENU 

The Format Menu enables you specify the format of new and existing cells and 
column width. When you press ADDTNL OPTIONS, the Format Menu appears. 

Figure 3-9 
Format Menu 

The formats you specify on this menu apply to current cells, or new cells. 
However, as with other Spreadsheet operations, you can further control which 
cells are affected by selecting a cell or an area of cells. You must do this before 
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using the options on the Format Menu. Selecting an area is described in Chap­
ter 2. 

Cells 

Use this option to change the format of the current cell or of all cells within a 
selected area. You must select the area prior to choosing the "Cell" option. If 
you want to change the format of all cells currently in use, choose the "Select 
all" option from the Edit Menu, then choose the "Cell" option. 

If you change a formatting characteristic for a selected area that contains clear 
cells, the clear cells are unchanged. Only the cells that contain a value or 
formatting characteristics are changed. 

When you choose "Cells," Spreadsheet displays either the Current Cell Format 
Menu or the Selected Area Format Menu, depending on whether you are changing 
the format of a single cell or a selected area. The two versions of the setup 
menu are shown in Figure 3-10. 

Current Ceil Format 

Dec1mal places: 2 10.00) 
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Text: Extended 
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Figure 3-10 
Cell Format Menus 
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The characteristics are the same in each menu, but the setting is different. You 
can see the setting of each characteristic in the Current Cell Format Menu. If 
you change the setting, the new setting is shown in the menu. The Selected 
Area Format Menu does not show the settings, since they may vary for different 
cells in the selected area. Furthermore, you may want to change only one of 
the formatting characteristics for all cells in the selected area, leaving the other 
characteristics unchanged. Accordingly, the menu shows a "No change" setting 
for each characteristic. 
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You change characteristics on both menus the same way, by choosing the option 
you want to change. The settings vary slightly between menus. For instance, 
"Currency" on the Current Cell Format Menu has only two settings: On and 
Off. On the Selected Area Format Menu, however, "Currency" has three settings: 
"Currency," "No currency," and "No change." Where there are multiple choices, 
the same menu of options plus the additional option, "No change," appears on 
the Selected Area Format Menu. When you change a setting on the Selected 
Area Format Menu, the new setting, which will be placed into every nonclear 
cell in the selected area, replaces the "No change" entry on the menu. 

The new settings do not take effect until you press EXIT. 

The first four formats on either Format Menu apply to numeric data in the cell: 

□ Decimal places: From O to 12 decimal places may be displayed. 

□ Currency: The currency symbol (defined separately) can be displayed 
(ON) or not displayed (OFF). 

□ Thousands: The number can be punctuated with the thousands 
separator (defined separately) at every third digit to the left of the 
decimal point. ON specifies punctuation, OFF specifies that the digits 
run together. 

□ Numbers: The number can be justified at the left or right end of the 
cell, or centered in the cell. 

The "Currency" and "Thousands" options turn these formatting characteristics 
ON and OFF, but the actual symbols used are specified by the National Symbols 
Menu, reached from the Personalize Menu. 

The fifth option of the Format Menus applies only to text in the cell: 
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□ Text: There are four options. Text in the cell can be justified to the 
left side of the cell, the right side of the cell, or centered in the cell. 
If the text is too long for the cell, it is left justified and an ellipsis 
replaces the rightmost character of the cell to show that some 
characters are not displayed. 

The fourth option, the "Extended" setting, specifies that the text 
should be left justified and if the text is too long to be displayed in 
the cell, it should be displayed in adjacent cells to the right, provided 
those cells are clear. 
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The last option of the Format Menus applies to all cells, numeric or text: 

□ Rendition: The displayed value of the cell can be shown in a normal 
type, or a heavier type, or it may be underlined, or a combination of 
bold and underlined. The four options on the menu illustrate the 
effect that each would have if chosen. 

Recall that when you change the formats of cells in a selected area, only cells 
that already have formats are changed. Clear cells do not change. If you want 
to set up formats in a selected area before entering values in that area, create 
a blank cell with the desired formats. Then replicate the blank cell (using the 
Edit Menu) into all cells of the selected area. 

New Cells 

Use this option to specify the format of new cells in the spreadsheet. The New 
Cell Format Menu has the same setup options as the Current Cell Menu used 
to change the formatting characteristics of a cell already in use. See the option 
descriptions in the previous section. 

Choose cell formats appropriate for your data. For example, one of the default 
new cell formatting characteristics calls for numbers to be displayed with two 
decimal places. If you know when you start to create the spreadsheet that most 
of the numbers on the spreadsheet will not require any decimal places, you can 
use the "New cell" option to change the new cell formatting characteristics to 
display no decimal places. Then as you enter numbers and formulas into clear 
cells, they will inherit the formatting characteristic that specifies no decimal 
places. If any particular cell requires decimal places, you can alter its formatting 
characteristics individually by choosing the "Cell" option. 

Column Width 

Use this option to change the width of the columns in your spreadsheet. 

Spreadsheet defaults all columns to a width of 11 characters. The width of any 
column may be changed. If an area is selected when the column width is changed, 
all columns included in the area are changed. If an area is not selected, only 
the column that contains the cursor bar is changed. 

When you choose "Column width" on the Format Menu, Spreadsheet displays 
a type-in menu that permits you to edit the current width. 
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The width of a single cell cannot be changed individually, but it is possible to 
display the text of a single cell in adjacent cells and thus display a long string 
of text. See the discussion of "Extended" text on the Cell Format Menu. 
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Chapter 1 

Introduction to Graph 

You can use Synergy Graph to create bar graphs, line graphs, pie charts, and 
point graphs. This chapter gives examples of each. 

BAR GRAPHS 

Bar graphs are useful to represent a small set of values. Graph draws three 
kinds of bar graphs: simple, stacked, and percentage (see Figure 1-1). 
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LINE GRAPHS 

When you have many data points, line graphs show trends more clearly. 
Graph draws three kinds of line graphs: simple, stacked, and percentage (see 
Figure 1-2). 
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POINT GRAPHS 

Point graphs are used for sets of fluctuating values. A scatter graph is a point 
graph with a straight line fitted to each set of points (see Figure 1-3). 
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PIE CHARTS 

1/85 

+ Salis 

Pie charts depict percentage relationships. You can draw a single pie or a set 
of pie charts (see Figure 1-4). 
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Chapter 2 

Sample Session 

Graph allows you to prepare graphs from numeric data. When you first select 
the Graph application, you see the data window on the left and the graph window 
on the right. 

A file selection menu requests that you select an existing data file or that you 
press INSERT HERE to begin creating a new graph. In this Sample Session, 
you will create a new graph, so press INSERT HERE and enter the nameJUL Y 
for the data file. (See your Hard Disk System User's Guide for more information 
on filenames.) 

After entering the name, press RETURN or DO. Graph removes the file naming 
menu and places a blinking cell cursor in the data window. 

The data window is titled "Data" and contains the data grid. The graph window 
is titled "Graph" and is initially empty. 

NOTE: If you have chosen the sample file EXAMPLE.TAB prior to running 
this sample session, you will see that the window sizes are different than 
those displayed throughout the Sample Session. Because window size affects 
how some graphs appear, you should change the window size back to the 
approximate dimensions shown. Press FS then ADDTNL OPTIONS to get the 
Synergy Window Control Menu. Change the size of the Data and Graph 
windows until they look like those in Figure 2-1. 

The following pages introduce you to the use of Graph. You will see how to 
create a graph and how to alter the graph format to change its appearance. You 
will also see how to save and restore a graph and how to use the HELP facility. 
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MOVING THE CELL CURSOR 

The data grid consists of 30 rows and 10 columns. The data window displays a 
portion of the data grid. On the left of the data grid are row numbers that 
define 16 rows. Across the top are column designations that define 3 columns. 
Columns and rows intersect to form cells (see Figure 2-1). 
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. ' 
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Figure 2-1 
Data/Graph State 

Initially, the cell cursor is positioned on the cell in the first row and first column. 
This cell is defined by the intersection of column A and row 1 and is identified 
as cell Al. 
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Let's experiment with moving the cell cursor. 

Example: Moving the Cell Cursor 

1. Press -+. The cell cursor moves one cell to the right. 

2. Continue pressing-+. When the cell cursor moves from column C to 
column D, Graph scrolls the data grid so that column D becomes 
visible in the data window. 

3. Experiment with the other ARROW keys. 

ENTERING DATA 

You enter a value in a cell by positioning the cell cursor on that cell and typing 
the value you wish to insert. When you finish typing the cell's value, press an 
ARROW key or RETURN to tell Graph that the value is complete. If you decide 
not to enter the value that you have typed, press CANCEL. You can use <XI 
to correct typing mistakes. 

When you finish entering values, press DO to direct Graph to display the graph 
in the graph window. 

When you start entering a value, Graph displays a character cursor to show 
you where the next character you type will appear in the data cell. You can 
enter a value that is wider than the column. As you approach the right edge 
of the column, the characters shift to the left to make room for the new characters. 

Example: Entering Data 

1. Position the cell cursor on cell Bl, enter Savings , and press l. Notice 
that the value Savings is entered in cell Bl and the cursor moves to 
cell B2. 

2. Position the cell cursor on cell A2, enter 1 /80 , and press -+. The 
value 1/1980 is entered in cell A2, and the cursor moves to cell B2. 
Graph changes the representation of the value from 1/80 to 1/1980 
because Graph reformats dates. 

3. Enter $30.2 , and press .J. The value $30.2 is entered in cell B2, and 
the cursor moves to cell B3. 

4. Continue entering the values shown in Figure 2-2, using the ARROW 
keys to position the cell cursor. Use <XI to correct typing mistakes. 

13 
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5. Compare your screen with the data grid in Figure 2-2. If you made 
any mistakes, you can correct them by moving the cell cursor to the 
cell with the error, typing the correct value, and pressing an ARROW 
key or RETURN. 

6. When you are satisfied, press DO to see the graph. 
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1/1982 139.2 , .......................................................................... 
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Figure 2-2 
Simple Bar Graph 

Your data values are represented as four bars. The first bar is the amount of 
savings as of 1/1980; the second, the amount as of 1/1981; and so on. Graph uses 
only t.he numeric data in the grid to make the graph. 

Observe that the vertical axis is labeled from $30 to $40. These amounts sho,v 
the range of values for the cells in column B. The horizontal axis is labeled from 
2 to 5. These numbers correspond to the rows that contain values. Graph au­
tomatically adjusts the axis limits to the scale of the numbers you have entered. 
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Example: Adding Data 

1. Position the cell cursor on cell Cl, enter Loans, and press .J. The cell 
cursor is no,v on cell C2. 

2. Enter $18.2, and press f. 
3. Continue entering the other values from the data grid in Figure 2-3. 

4. Press DO to see the graph. 

....................... Sav m9s ... ~LOa."ls ......... :. 
1/1980 130,2 S18,2 

·······················•············--·········•···••n••··············•· 
I 3 1/1981 135,9 S19,8 

····••·•···············•·················· .. ···•························· 
1/1982 S39,2 S25.3 

··············•·•······ .. ······················· .. ·······················•· 
1/1983 S38.5 525,7 

!5·················· ... : ....................... _ 

• 7 
8 

···············································•·······················•· 
' ······················· .. ······················· .. · ...................... ~. 

I 9 ..................................................................... ..J. 
10 , 

·••···················· .. ·••••••••••••••• .. ••••• .. •••••••••••• ..... , ••••• j. 

11 ·······················•·········· ...................................... . 
12 ! ......................................................................... 
13 ' 
14 ....................... · ............................................... :. 
15 , : 

....................................................................... 1. 
I 

Figure 2-3 
Graph with Added Data 
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Observe that you now have two sets of four bars. The black bars represent 
Savings, and the checked bars represent Loans. 

Again the vertical scale has been automatically adjusted to the scale of the 
values in the grid. 
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LABELING THE GRAPH 

Although you have entered labels in the data grid, these labels are not shown 
on the graph. Graph takes its label settings from the legend and axis range 
options on the Graph Menu. The standard default format specifies range settings 
that direct Graph to use the column letters as labels in the legend box and row 
numbers as labels on the horizontal axis. To direct Graph to use your labels for 
the legend and axis, you must change the legend and axis ranges. 

Your legend labels (Savings and Loans) appear in row I of columns B and C. 
To use these labels, you designate these cells in the legend range. 

Your horizontal axis labels appear in column A, rows 2 through 5. To use these 
labels, you designate these cells in the axis range. 

Example: Changing the Ranges 

16 

I. Press F12 to get the Graph Menu. Position the cursor on the 
"Legend range" option, and press <:RJ three times to remove the 
default legend range. 

2. Enter 81 :C1 for the new legend range, and press RETURN. 

3. With the cursor positioned on the "Axis range" option, use <:RJ to 
remove the current setting. 

4. Enter A2:A 1 o for the new axis range, and press RETURN. (Your 
labels occupy cells A2 through A5, but you allow room for expansion 
by entering this range.) 

5. Press EXIT to remove the hanging menu and see the graph (see 
Figure 2-4). 
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raph 

---------
1 ...................... JS av i ns.s .. ,Loans ......... ;. ! 
2 1/1980' 130.2. 118,2 ....................... ·•·••···' 
3 ······11199( 135,9 119,9' I 

4 ····111982 139.i 125,3 
!5 ······111993 138.0° 125,7 

0 :::::::::::::::::::::::::::::::::::::::::::::::--: 
7 ' ' I ........................................................................ j, 

B · __ i 
9 ······· ... ·····................................. r 

10 ·······················•·······················:······················.I· 
11 ' ! 
12 ·······················•·······················•···················· .. ·r 
13 • 7 1 

!; ::::::::::::::::::::::i:::::::::::::::::::::::r:::::::::::::::::::::::I: 

Figure 2-4 
Graph with Labels 

The legend box now shows that Savings are associated with the solid bars and 
Loans with the checked bars. The horizontal axis is labeled with the dates given 
in cells A2 through A5. Since no data appears in rows 6 through 10, no labels 
for that data appear on the graph. 

When dates are used to label the horizontal axis, Graph lays it out according 
to time. The elates given in the label strip in Figure 2-4 are equal intervals of 
time. If the elates were not equal intervals, Graph would space the bars on the 
axis to reflect this fact. 
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CHANGING THE TIME AXIS 

To see the way Graph lays out the horizontal axis for unequal intervals, we 
need to add another value. Let's add an entry for April 1983, so that the date 
values do not specify equal intervals. 

Example: Adding Another Date 

1. Position the cursor on cell A6, enter the date 4183, and press --+ . 

2. Enter the values for Savings and Loans for that date, as shown in 
Figure 2-5. 

3. Press DO to see the graph. 

:·~~;I'.'<' c~\' .* :•. > .. ":-
• ,,:.,/f.: ... 

...................... ISav in9.i jLOini ...... ...i. . 
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... ·111901° · s35,9•········u9·,e·· 

. 1/1982 S39,2 .... S26,3° 
1 / 1983 S38, 6~ ...... S26·. 7'· 

.. 4/1983 ········ S39, e°'·······s29·, e•· '/· 

:::::::::::::::::::::::::::::::::::::::::::::::-• 
I •· 

·······················• .. ·····················--i --·1·. 
....................... ~···· .. ··········· ...... _, ----'· 
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......... ········r--...__-········••I• 
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... , ............... r ............ . 
"' ~ .............................. . . ~ ............... [ ............. .. 
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................ : 
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.... , 
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I 
_______ ........ __ _ 

1111 1111 

Figure 2-5 
Graph Showing Time Relationships 

Observe that the horizontal axis 1s divided to display the time relationship 
between the bar groups. 
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GRAPHING A SUBSET 

You can use the legend and axis range settings to direct Graph to plot a subset 
of the data grid. Suppose, for example, that you only want to look at the years 
from 1982 on. To do this, you adjust the legend range so that it contains only 
the labels in cells A4 through A6. 

Example: Graphing a Subset 

1. Press F12 to get the Graph Menu. 

2. Position the cursor on the "Axis Range" option. 

3. Change the axis range to A4:A6 and press RETURN to complete the 
change. 

4. Press EXIT to remove the menu and see the graph (see Figure 2-6). 

....................... 15-.~.'f.Jr:i.s.s. .. ~~~.a.r.i~ ........ ;. 
1/1980! 130.2 S18.2 

·······················-t···········•··••·······•·····················•·•· 
! 3 1/1981: 135,9 119,8 
· 4 ·· 111902~ 139,2 ·······•2s.f 
! 5 .... 1/1983 138,6° 126,f 
1 s ···;;11983 139,9 129.-s· 
' 7 .................... :····· .................. . 

' 8 
g 

Figure 2-6 
Graph of Data Grid Subset 
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Note that Graph has again automatically adjusted the vertical scale to reflect 
the values in the new range. All examples so far in this sample session use the 
automatic setting for the horizontal and vertical axes. This means that Graph 
chooses values for the upper and lower limits and the increments, based on the 
values entered in the range specified. 

CHANGING THE VERTICAL AXIS 

You can change the values for all these settings by using the Format Menu. 
For example, if you want to view more of the column representing loans, you 
can manually set the upper and lower limit and the increments of the vertical 
axis. 

Example: Changing the Vertical Axis 

1. Press ADDTNL OPTIONS to get the Format Menu. 

2. Move the cursor to "High" under the "Vertical axis limits" option. 
Use <:zJ to remove the current setting. Enter $40 and press 
RETURN. 

3. With the cursor on "Low," remove the current setting. Enter S20 and 
press RETURN. 

4. With the cursor on "Increment," remove the current setting. Enter 2 
and press RETURN. 

5. Press EXIT to accept the changes. Graph redraws the graph, using 
the new values you just entered. 

CHANGING THE COLUMN WIDTH 

The data grid contains 300 cells. If you want to use cells that are not visible in 
the data window, you can scroll the cells through the data window, enlarge the 
data window, or change the column width so that more columns can be displayed 
in the data window. 
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Let's experiment with changing the column width. 

Example: Changing the Column Width 

1. Position the cell cursor on a cell in column B. 

2. Press F11 to get the File/Edit Menu. 

3. Position the cursor on the "Change column width" option, and press 
DO. A flashing bar appears on the right edge of column B. 

4. The • and .,. keys are used to decrease or increase the column 
width, so press ~ twice to decrease the width of column B from 
eight characters to six. 

5. Press DO to record the change. 

Your data window now looks like that shown in Figure 2-7. If you repeat the 
process for column C, your data window will look like the data window in 
Figure 2-8. 

1 ...................... .1s av i ns.i .. :Loans ......... !. 
2 1/1980 S30,2 S18,2, 
3 111981 S35.9 s19·,s· 
4 1/1982 S39.f ·s25,3' 
5 1/1983 S38.6. ·s25·,7 
6 4/1983 S39,8 S29~i 
7·······················:·······················-

8 I 
.. ,, .................................................................. ,1, 

9 I 
·······················•··············· ... • ............................ J. 

10 1 I ! 
11 ······················r····················r~· 

12 ······················.I.········ .............. I.. ..................... . 
13 I 14 ....................... r I . 

......................................................................... 
15 i . 1 ............................................... + ....................... :-

Figure 2-7 
Graph with Varied Column Widths 
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REMOVING DATA 

You can remove all of the data from the data grid by choosing the "Clear all" 
option from the File/Edit Menu. However, if you want to remove only a portion 
of the data, you can enter blank values in specific cells. 

Let's remove the sixth row so that the bars will be equally spaced once more. 

Example: Removing Data 

I. Position the cursor on cell A6 and press SPACE followed by ➔. Cell 
A6 now contains a blank, and the cursor is positioned on cell B6. 

2 .. Press SPACE and ➔ to remove the value in B6. 

3. Press SPACE and l to remove the value in C6. 

4. Press DO to see the graph (see Figure 2-8). 

Figure 2-8 
Graph After Removing Data 
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CHANGING PATTERNS 

A bar is distinguished by its pattern. You can change the pattern of a bar by 
choosing the "Pick patterns" option from the File/Edit Menu. You select the 
pattern from a menu of patterns and colors (see Figure 2-9). If you have a color 
system, you can also choose the color of a bar. 

: 6 
7 
8 
9 

i L1g1nd 

..................... Ji.! .. Savings 
... .J.!J~.~.?L.... Loans 
.. ...1119811 ...... . 

1/19821 
·······················•······· 

1/1983 
I ............................. ,. 
' ·······················•······· 

........... , .................. . 
10 I 

, .............................. . 
11 ... , .......................... . 

. 12 I 

Curr,nt Highlight Pattlms Colors 

no •= ■ no 

m■ no 

~«azz no !!Hi 
no 

~~ ~ no 

■ Et?: Et:~~!:t;~ no $5: -no 
~~ -

!1111111111111111111!11 
' I no 

~~ ! i ~~ no I ' 

Pr1ss EXIT to accept values 13 ................... ...1 ...... . 
14 i --.---------------................................................ __ _, 

i:; 

Figure 2-9 
Pattern Menu 
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Let's try changing the pattern of the bar that represents Savings. 

Example: Changing Patterns 

1. Press F11 to get the File/Edit Menu, position the cursor bar on the 
"Pick patterns" option, and press DO. 

2. Position the cursor bar on the current pattern box for Savings and 
press DO. Graph displays a second cursor in the menu. You can move 
this cursor to the pattern you want to select. 

3. Move the cursor to the horizontal stripe pattern, and press DO to 
choose that pattern. 

4. Press EXIT to see your graph (see Figure 2-10). 

....................... .IS&v in ... :Loans ... ! ............ . 
1/1980 S30,2 S18,Z 

... 111901· S3!s."9' S19."8 ............ . 

1/1982° S39,2 S26,f .... .. 
. 1/1983 S38.E, sze,·."7'""" .... .. 
• i • l ... .. 

' I 

:::::::::::::::::::::::::::::::::::::::::::~:::::::::::: 
. . .. . ....... ... .... ... . ·: ......... ' ........ ,. ' ................ ~··· .... ·····. 

.................. i .................. :--................ ,1 ........... .. 

.................. i .................. i .................. i ........... .. 

.................. : ..................................... i ............ . 
·············· .... ! .................. , .................. ; ............ . 

' ' .................. j•••••••• .. ••••••--t•• I 

i I 
.................. , ••••.••••••••••••• ! .. ••········· .... •t·•"'''''""" 

I : ; 

....................... !•···· .. •••••••• ...................... 1,-•·····oo••· 

Figure 2-10 
Graph with Different Patterns 
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ADDING HIGHLIGHTS 

If you want your bar chart to look three-dimensional, you can add highlights. 

Example: Adding Highlights 

1. Choose "Pick patterns" from the File/Edit Menu, as in the previous 
section. 

2. Position the cursor bar on the Highlight column for Savings, and 
press DO. The setting is flipped from NO to YES, indicating that 
Savings will be highlighted. 

3. Repeat this process for Loans. 

4. Press EXIT to see the highlighted graph (see Figure 2-11). 

i 1 
2 

l 3 

Sav rn ... ,Loans 
···•···············•···•··•···········•··•···· 
1/!980 130.2 118,2 

······•················ ·············•······"·· ......................... .. 
1/198~ 135,9 119,8 

I 4 1/!962 139,2 126,3 
j 5 · ---iiigs3 s3ei":-s·--,2s·:;; -------------

......................................................................... 
; 6 

•7:::::::::::::::::::::::::::::::::::::-::::::::: 
I 8 

· 14 
··········································"································ : 15 

Figure 2-11 
Graph with Highlighting 
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CHANGING THE ORIENTATION 

The standard default format specifies an orientation that produces a column-by­
row graph. It associates columns with the legend range, and rows with the axis 
range. Thus, the values in a single column are represented by bars of the same 
style (pattern and color), and the values in a single row are represented at the 
same point on the horizontal axis. 

You can change this orientation and produce a row-by-column graph by giving 
the row labels in the legend range, and the column labels in the axis range. 

Example: Changing the Orientation 

26 

1. Press F12 to get the Graph Menu and position the cursor bar on the 
"Legend range" option. 

2. Use ~ to remove the current values, enter A4:A5, and press 
RETURN. 

3. With the cursor bar positioned on the "Axis range" option, remove 
the current value, enter 81 :C1 , and press RETURN. 

4. Press EXIT to see the graph (see Figure 2-12). 
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~ 

6 

:Savi n ... :Loans 
1/1980 130.Z 118.2 
1/1981° 135.9. 119.8 
1/1982 139,2 126.3 ....................................................................... 
1/1983 138.6 126.7 

·······································································•··· 
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Figure 2-12 
Graph with Different Orientation 
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Observe that the horizontal axis is now labeled with Savings and Loans, and 
the legend identifies patterns for 1/82 and 1/83. 

IDENTIFYING THE GRAPH 

You can add r. title, a subtitle, a footnote, or other identification to your graph. 

Example: Identifying the Graph 

1. Press F13 to get the Text Menu. 

2. Position the cursor on the "Title" option, enter the title MUTUAL 

BANKS, and press RETURN. 

3. With the cursor on the "Subtitle" option, enter the subtitle Savings 
and Loans (in millions}, and press RETURN. 

4. With the cursor on the "Footnote" option, enter the footing Source: 
Financial News, and press RETURN. 

5. Press EXIT to see the graph (see Figure 2-13). 
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~ 4---11S av m .. lLom,s ! 

1/1986 130.~ 118.Z -4-.....;;..;..c..c.il ..... ·1 ............ . 
1/1981. 135,9: 119.8 
1/1982: 139,21 126.3! .... 
1/1983' 138.6: 126.7: 

:::::::i:=~= · .. 
. . ........... ' 

Figure 2-13 
Graph with Titles 

FULL SCREEN GRAPH 
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Added identification is sometimes difficult to read, since it decreases the size of 
graph. You can get a full-screen picture of the graph by choosing the "Full 
screen graph" option from the File/Edit Menu. 

Example: Full Screen Graph 

28 

1. Press F11 to get the File/Edit Menu, position the cursor bar on 
the "Full screen graph" option, and press DO. The graph is now 
expanded to fill the screen, as shown in Figure 2-14. 

2. Press RESUME to remove the full screen graph. 

l . 
1 
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MUTUAL BANKS 
Savings and Loans (in millions) 

140-----, 
138 _ ............... §§1;;~ 
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132 .;. .............. . 
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128-······ .. ······· 
126-:··············· 
124 .;. .............. . 
122•··············· 
120 ' 
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··•········· ............................................ , ............................ ~ 
' __ ,, ......................................... .. 

---······································· 

. ... , 

Loans 

1/82 
1/83 

Sourc11 Financial N1ws 

Figure 2-14 
Full Screen Graph 

SAVING THE DATA 

You can save the data, window parameters, and the graph format settings for 
later use. When the file in which you saved this information is loaded and the 
graph is redrawn, the graph will look just as it looked when you saved the data. 

Example: Saving the Data 

1. To save the data, window parameters, and graph format settings, 
press F11 to get the File/Edit Menu, position the cursor bar to the 
"Save data" option, and press DO. 

2. You are asked to confirm the filename for the saved data. Use the 
name that you supplied at start-up by simply pressing DO. 

The data and settings necessary to reproduce the graph are now saved in the 
file JULY.TAB. 
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RESTORING A SAVED GRAPH 

You can now recall the graph you just saved. First let's clear the data grid and 
graph window to show that the graph is being restored from the saved data. 

Example: Restoring a Saved Graph 

1. Press F11 to get the File/Edit Menu, position the cursor bar on the 
"Clear all" option, and press DO. 

2. Press F11 again, position the cursor bar on the "Load data" option, 
and press DO. You are asked to choose the file to be loaded. 

3. Move the cursor bar to JULY.TAB, the name of the file that you 
just saved, and press DO. The saved graph is restored. 

GETTING HELP 

Graph also has an extensive HELP facility. If you are uncertain about what to 
do when using Graph, press HELP. You will be given HELP that pertains to 
what you are presently doing as well as a list of related topics on which you 
can get more information. One of these topics is the HELP index, which is a 
list of all topics on which HELP is available. 

Example: Using HELP 

1. Press F12 to get the Graph Menu, press DO to change the graph 
type, and press HELP to get more information on the bar graph type. 
You are given a description of a simple bar graph and the options of 
getting more information on other bar graphs and attributes, or of 
selecting "HELP index" to see the other topics on which HELP is 
available (see Figure 2-15). 

2. Position the cursor on the "HELP index" option and press DO. You 
are shown an index of HELP information. You can choose any topic 
and press DO to get information on that subject. 

3. Try choosing topics. Within the HELP for a topic, you can use PREV 
SCREEN and NEXT SCREEN to move backward and forward 
through the HELP information base. 

4. Press RESUME to leave HELP. 

Press EXIT to leave the menu of graph types. Press EXIT again to finish with 
the Graph Menu. 
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You have now completed the Sample Session, and you are ready to use Graph. 
The next section explains the Graph concepts, and the last section gives instructions 
on using Graph. 
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Figure 2-15 
Sample HELP Frame 
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Chapter 3 

Concepts 

Graph uses two windows, the data window and the graph window. The numeric 
values in the data grid are used to create the graph. The graph format settings 
determine which values are plotted and how the graph looks. 

Graph menus let you change the graph format settings, save and restore data, 
and view the graph on the full screen. 

DATA 

The data grid is the rectangular array that fills the data window. It consists of 
10 columns and 30 rows. Columns are identified by letters, and rows by numbers. 
The graph is drawn from the numeric values in the data grid. These values can 
be entered from the keyboard, loaded from a table file, or copied from the 
clipboard. 

A cell in the data grid is designated by a column letter and row number. For 
example, cell C5 is the cell in column C of row 5. 

More columns can be displayed in the data window by enlarging the window or 
by decreasing the column width. Columns and rows that are not visible can be 
scrolled into the window by moving the cell cursor in the desired direction. 
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Data Types 

A data cell can contain a numeric, text, or date value. Graph determines the 
type of a value by its format: 

□ A numeric value can be expressed in decimal, scientific, or dollar 
notation. A numeric value can contain up to 15 digits. Numeric values 
are shown right-justified in a cell. 

□ A text value is made up of letters, digits, and punctuation. A text 
value can contain up to 20 characters. Text values are shown left­
justified in a cell. 

□ A date value is made up of a month, a day, and a year, in that order. 
The day, or the month and day, can be omitted. Date values are 
shown right-justified in a cell. 

Numeric values are graphed, and text or date values are used as labels to 
identify the graph. When drawing a graph, Graph treats text and date values 
as blank cells and does not graph them. Therefore, if your data grid contains 
only text or date values, no graph is drawn; the blinking cursor remains in the 
data window. You must enter at least two numeric values in the data grid before 
a graph can be drawn. 

Some examples of values are: 

Numeric Values Text Values Date Values 

$2.50 Apples 5/10/1971 

0.002345 ACME Corp. January, 1968 

123E-08 -0918hn32 Dec 18, 1969 

1982 1982 1982 

Numeric Values 

A numeric value can be either a number value or a dollar value. 

□ A number value can be expressed in decimal or scientific notation. In 
decimal notation, it can contain a sign, digits, commas, and a decimal 
point. In scientific notation, it can contain an exponent. 
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□ A dollar value consists of dollars and cents. It begins with a "$" to 
differentiate it from a number value. 
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You can use commas in numeric values to make the number easier to reacl. You 
can also use negative values, but they are meaningful only in simple bar or line 
graphs. An empty cell or a cell with a text or date value is treated as a blank 
cell and is not graphed. 

Decimal Notation 

12,456.2 

.000376 

2,000,000 

Text Values 

Number Values 

Scientific Notation 

.124562E5 

.376E-3 

.2E+7 

A text value is any value that is not a numeric or date value. 

Dollar Values 

Dollar Notation 

$12.56 

$1,458 

$.343 

Text values are particularly useful when you want to specify exactly how the 
labels along the horizontal axis will appear. When you use text values as labels, 
Graph displays the text values along the horizontal axis exactly as you entered 
them. For instance, you can enter dates as text values. This keeps Graph from 
behaving as it normally does and labeling the graph \Vith dates that you may 
not want. 

Use a single quotation mark to indicate a text value. If a value begins with a 
single quote, Graph recognizes that the value is a text value, discards the quote, 
and displays the value left-justified in the cell. For example, if you enter 25, 
Graph assumes that it is a number; however, if you enter '25, Graph recognizes 
it as a text value and displays 25 (without the quotation mark). 

Date Values 

A date value has special significance to Graph. If the horizontal axis is labeled 
by date values, Graph divides the axis into units of time. These units may not 
always be the dates you want, and they may not be spaced along the horizontal 
axis as you would like. To change these dates, either specify horizontal axis 
limits and increments or enter the dates as labels by making them text values. 
In both ways, you can control precisely which dates are displayed along the 
axis. For more information, see "Horizontal Axis Limits" in Chapter 4. 

A date value consists of a month, a day, and a year. The day, or the month 
and day, can be omitted. 
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Months can be specified by name or number. Abbreviated month names can also 
be used. Years can be specified by four digits or two digits. If only two digits 
are specified, then the century is assumed to be 1900 for numbers greater than 
49, and 2000 for numbers less than or equal to 49. - ~ 

The slash character is used to indicate a date value if the date value could be 
confused with a number. For example, if you enter 1982, Graph assumes it is 
a number; however, if you enter /1982, Graph recognizes that it is a date value. 

Mixing Types 

Numeric values can be used as labels, but labels cannot be used as numbers. 
Graph considers label values as blanks when creating the graph. 

For example, in the graph shown in Figure 3-1, cell A3 contains a text value 
(in this case, a space). Graph treats that cell as a blank cell in the graph and, 
therefore, does not produce a solid bar in group 3. 

................... ..1i .................... 2. 3:. 
····················21 3: 4!. 

i 5· 5 
······················-r·····················•~·-

·······················~············· t . 
................. i ....................... t i ~--

······· .. ···· .... ~ ......................... __ 
! . 

.................. ·-----

................. t ....................... r················· 

:::::::::::::::::f:::::::::::::::::::::::!·-
1 

::::::::: ........ f-··········•-1 

Figure 3-1 
Graph with Mixed Data Types 
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Entering Data 

The cell cursor identifies the current cell. To enter data in a cell, position the 
cell cursor on the cell and enter the value. As soon as you type a character, 
Graph blanks the cell and echoes the character. 

To finish entering a cell value, press RETURN, ENTER, or an ARROW key. If 
you do not wish to replace the old value, press CANCEL to discard the new 
value and restore the old value. 

Editing Data 

To edit a cell value, press F17. Graph displays a cursor in the current cell with 
the existing value. You can move the cursor with the +- and -+ keys. Use 
<:EJ to delete the character to the left of the cell cursor. To insert a character, 
type it. 

Editing a cell value does not change its data type. For example, suppose you 
want to enter the numeric value 12.57 but you make a mistake and enter the 
value 12>57 instead. Graph assumes that 12>57 is a label value because it 
contains a character that is not allowed in a numeric value. If you edit the cell 
to correct the typing mistake, the cell will contain the correct value, 12.57, but 
the label type will be retained. Graph will left justify the value, indicating that 
it is a label, and will consider the cell to be blank when drawing the graph. To 
change the data type, you must reenter the correct value instead of editing the 
existing value. 

Column Width 

A column in the data grid can be from one to twenty characters wide. The 
standard default format specifies each column width as eight characters. You 
can increase the width of a column to display more characters in that column, 
or decrease the width to fit more columns in the data window. You change the 
column width by selecting the "Change column width" option from the File/Edit 
Menu. 

The length of the value in a cell is independent of the width of a column. If you 
enter .a value that is longer than the column's width, the value is scrolled through 
the column window. When you finish entering the value, the initial characters 
are shown in the column, and an ellipsis (. .. ) indicates that more characters 
follow. 

Saving and Restoring Data 

You can save the values in the data grid, the graph format settings, and the 
window environment by selecting the "Save data" option on the File/Edit Menu. 
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You can load data and format settings that were previously saved by selecting 
the "Load data" option on the File/Edit Menu. 

You can also use the "Save data" and "Load data" options to establish your own 
default format, independent of the actual values in the data grid. For more 
information, see "Default Format" later in this chapter. 

Clipboard 

The clipboard 1s used to move data between applications m the Synergy 
environment. 

Graph can write the contents of the data grid, the screen representation of the 
data grid, or the graph to the clipboard. The data grid contents can be used by 
Spreadsheet or Datamanager. The graph or the screen representation of the 
data grid can be used by PROSE PL US. Graph can read data from Spreadsheet 
or Datamanager into the data grid. 

To access the clipboard, press F11 and choose either of the clipboard operations 
from the File/Edit Menu. 

GRAPHS 

Graph draws the graph in the graph window. It uses the portion of the data 
grid specified by the legend and axis ranges to create the graph, and the graph 
format settings to determine the kind of graph to draw. 

Magnitude, row position, and column position are represented in the graph. The 
magnitude is always presented on the vertical axis. The row position can be 
presented along the horizontal axis or in the legend; similarly, the column position 
can be presented in either of these ways. The legend and axis range settings 
determine this association. 

Ranges 

Graph lets you specify two ranges: legend and axis. These determine three 
things: 

□ The labels that Graph uses for the legend and horizontal axis 

□ The portion of the data grid that is graphed 

□ The graph orientation 
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The standard default format specifies these range settings: 

Legend Range: A:J 

Axis Range: 1:30 

The ranges are set so that the graph is labeled with numbers along the horizontal 
axis and by letters in the legend; the entire data grid is graphed; and rows are 
plotted along the horizontal axis and columns identified by patterns or colors. 
Figure 3-2 shows a graph made with the standard default range settings. 

The maximum number of legends that Graph displays is 10; the maximum number 
of labels displayed along the horizontal axis is determined by the size of the 
graph window and the length of the labels. 

Typ1: Bar 

L1g1nd range: ..,_.9;...._J __ ---.. JI..~.~.~.~ Axis rangt: .,.1 ;_30 __ 
2 Profit 112.3 

4/1984 7/1984 
........ ,12 .. 9 .......... 115 ... 1:... • 

Sales ............ 137 .. 9 Pl"fts :rnIJ to ac:ctpt values. .. ...... 136 .. 4 .......... 162 ... 3 ........................ ~ ............ . . 

Graph 

Figure 3-2 
Graph with Standard Default Range Settings 

Labels 

A range specifies a label strip. A label strip can be a number range, letter 
range, or cell range. If the label strip is a number range, the numbers are used 
as labels. For example, if the axis range is 2:9, the horizontal axis is labeled 
with the numbers 2 through 9. 
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If the label strip is a letter range, the letters are used. If the legend :range is 
A:D, the legend identifies the letters A through D with the styles (patterns, 
markers, or colors) used as distinguishing characteristics in the graph. 

If the label strip is a range of cells, the contents of those cells are used as labels. 
Figure 3-3 shows a graph that uses the contents of cells for labels. 

B '. Ltgtnd r11191: B1;I1 

... J.itf·~·~ Axis r11191: A2:A3 
4~~~~; 7

~~~~~;---, -

137.9 Pm, IEID to acclflt valL.VS, 136.4 162,3' i ....,-------==:,__ _ _;_ __ --J·······•••••••······•··•·••••••·•••·•••·······"I·•·· 

Figure 3-3 
Graph with Labels 

11 1/B3 

I
I 4103 

I 7/83 

I 
10/83 
1/84 

11 4104 

If the cells you are using for labels contain numbers or dates, Graph divides 
the axis into units, either of quantity or of time. These units may not ahvays 
be the ones you want, and they may not be spaced along the horizontal axis as 
you would like. To change the numbers or dates displayed along the horizontal 
axis, either specify horizontal axis limits and increments or enter the numbers 
or dates as text values. In both ways, you can control precisely what is displayed 
along the axis. 

Data Grid Subset 

To draw the graph, Graph uses the values of the cells in the portion of the data 
grid that is defined by the intersection of the legend and axis ranges. Cells that 
are blank are not graphed. 
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The standard default format supplies range settings whose intersection is the 
entire data grid. 

Figure 3-4 shows a graph of a portion of the data grid. 

ldPt: Bar 

e I L19end range: B1;D1 

... J/;.~-~.~ Axis rll"\911 AZ;A3 
Profit ! 512,3 
S~l.es ..... J ........ S3i',9 Pren CEElI] to .::cept v■lUH, 

I ...................... : ................ . 

Craph 

Figure 3-4 
Graph of Portion of Data Grid 

Graph Orientation 

1/83 i 
I 

4/83 : 

7/83 ! 

A graph can be drawn row-by-column or column-by-row. If you give row numbers 
in the axis range and column labels in the legend range, the rows are plotted 
on the horizontal axis and the columns are identified by styles (patterns, markers, 
or colors). 

If you give numbers in the legend range and letters in the axis range, the 
columns are plotted along the horizontal axis and the rows are identified by 
styles. 

If you give cell names, the variable dimension determines the orientation. For 
example, if you give Bl:BlO _as the axis range, the number part of the cell name 
is the variable dimension, indicating that the rows are to be plotted along the 
horizontal axis. 
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Figure 3-5 illustrates a graph with the columns plotted along the horizontal axis. 

i L191nd ran911 A,2;83 ---
11198~ A~is ran911 81;01 
112.3 

----.37.9 Prns EEEI!J to ICClpt VllUH. 

I I ................................................................................................................................... , ................................................... , ....................... ··········" 

Graph 

150 =::::::::::===-=-=-=-=-=-=-=-=-~;::;;..:;;,..;::;;.,..:;:;:::::====~=ffl:'.: 140 :······ ........................................ =====~~~m::::: __ -ff~EH :::: 

s3o l ·· :::. ::::: ,2oi11--il=-il S10 ... ········· .......... ···• so~··· ......... .......... . .. . 

1/83 3/83 5/83 7 /83 

Figure 3-5 
Example of Orientation 

Restrictions 

If you give ranges that violate the rules below, Graph tells you that the ranges 
you specified must be corrected before a graph can be drawn. You can correct 
the ranges either by specifying new ranges that accord with the rules below, 
or by deleting the ranges you just specified and allowing Graph to supply default 
settings. 
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The rules for specifying the coordinate ranges are: 

□ One range must be a column label strip, and the other a row label 
strip. 

□ No cell may be part of both ranges at the same time. 

□ Ranges cannot intersect. For instance, let's look again at Figure 3-5. 
Notice that cell Al is blank and that it appears in neither the legend 
nor the axis range. This keeps the ranges from intersecting. But if 
you try to change the axis range from B1:Dl to Al:Dl, Graph gives 
you an error message since the ranges now intersect. 

□ Either range can consist of only one cell, but both ranges cannot 
consist of only one cell each. For instance, you can specify a legend 
range of A2 when the axis range is B1:D1 but you cannot specify 
a legend range of A2 when the axis range is Bl. 

Graph Size 

Graph draws the largest graph that will fit in the graph window. The graph is 
essentially square. Consequently, the shape of the window may affect the placement 
of the graph and its legend. 
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The legend is usually placed to the right of the graph, but in a tall, narrow 
window the legend is placed below the graph, as shown in Figure 3-6. 
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Figure 3-6 
Window Size and Legend Placement 

46 



CONCEPTS I CHAPTER 3 

...................... JS•v.in9s ... 1Loiilns~-J...----1----1 
111900' 130.2' 110.2; 

...... 1/198t' ...... 135.f 119.e' ----1----1 

4 ...... 1/1982. 139.2· 126,3° 
5 ...... 1/1983 138.6 126,7 . 

6 : .... ~/J~.~} .......... ~.~.~.~i 129,8 ....................... , ...................... . 
~ ............ , .......... ~ ....................... ~ ........................ : ...................... . 

........................................................................ :: :~~ ~+- __ ;· .. -.. -.... -.... -.... -.... -.... 1-\1-_-_ -_ -_-_:-:::~-

12 .. 

13 
14 ........................ ,1...... __ ;,.._ ____ --+---t 
Hi 

, . 
, ,>•dM;'~k., ~-"""~• ''>-if 

raph 

140 ----------
138 
136 

i 
134; 
132; 

:~~ ............................................. , ... : 
126 -------.:l:l::....a.:..... 

1/82 7/82 

fl Savings 

Im Loans 

1/83 

1 ....................... JS av i nss ... ,Loans ......... !. "°'-----------.--
I Savings 

Loans 
2 1/1980 130,2 110.2: 
3 .... .,111901 ......... 135 .•. 9 ......... .s1 s .•. 0; 
4 1/1982 139,2 126,3 
5 . 1/1983 138.6 126,7 
6 4/1983 139.8 129,8 

7::::::::::::::::::::::::::::::::::::::::::::::::-. 
8 ., ........... , ...... , .. : ........................ ; ........................ i. 
9 ................................................ !.. ...................... . 
10 ....................... L ......... ·-----i 
11 
12 i 
13 1 i 

14 
-----···--!-· ...................... . 

....................... .._ __ .,..__---! 
15 ....................... : ........................ 1-' ---1 

' . 

Figure 3-7 
Effect of Window Size on Graphs 
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Window size affects how text and numbers display, as well as the increments 
Graph uses, when the automatic setting is in use. Figure 3-7 shows the same 
graph in two different sized windows. Note in particular how the increments 
and placement of the dates used in the horizontal axis are affected. 

Window size also affects Graph's ability to accommodate the horizontal or vertical 
limits and increments that you specify. Sometimes, no matter how large the 
window, Graph simply does not have room on the screen for a graph of your 
specifications. For instance, you may specify that the horizontal axis begin at 
0 units, end at 80,000 units, and be marked off in increments of 10. To draw 
such a graph, Graph would need far more space than is available on the screen. 
Because it has only a limited amount of space, Graph gives you an error message, 
then uses the limits you specify to calculate a more suitable increment, and 
draws the graph using that increment. This increment may not be the one you 
want. You can change the increment by adjusting the horizontal or vertical 
limits until Graph can accommodate both the limits and the increment you 
specify. 

Similarly, the limits you specify may produce a graph that is so compressed you 
cannot distinguish one bar in the graph from another. For instance, bars occurring 
close to the vertical axis in the above example may be indistinguishable on the 
screen from the vertical axis itself. You can correct this situation by specifying 
different horizontal or vertical limits. 

Graph Types 

Graph can draw the following kinds of graphs: 

Bar graph 
Une graph 
Point graph 
Pie chart 

Simple 
Simple 
Simple 

Stacked 
Stacked 
Scatter 

The standard default format specifies Simple Bar as the graph type. 

Bar Graphs 

Percentage 
Percentage 

Graph offers three different kinds of bar graphs: simple, stacked, and percentage. 
A simple bar graph has groups of bars of different patterns. For every label in 
the axis range there is a group of bars; and for every label in the legend range 
there is a bar of a particular pattern within each group of bars. The vertical 
axis represents the magnitude of the cell values. 
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Figure 3-8 illustrates a simple bar graph. The legend range is set to the legend 
label strip (Bl:Dl), and the axis range is set to the axis label strip (A2:A3). 

, The height of each bar represents a cell value. The first solid bar in the figure 
represents Salary in 1980. 

Figure 3-8 
Simple Bar Graph 

Stacked Bar Graphs 
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A stacked bar graph contains one bar for every label in the axis range. A pattern 
is associated with every label in the legend range. Magnitude is representecl 
along the vertical axis. 

For each label in the axis range, Graph produces a single bar. The height of 
the bar is the sum of the values of the cells associated with that label. 
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Figure 3-9 illustrates a stacked bar graph. The legend range is set to the legend 
label strip (Bl:Dl), and the axis range is set to the axis label strip (A2:A3). 

Each bar contains a solid section for Salary, a checked section for Interest, and 
a waffled section for Dividends. The size of each section reflects the value of 
the associated cell. The height of the first bar is the sum of the values for 1980, 
and the height of the second bar is the sum of the values for 1982. 

Figure 3-9 
Stacked Bar Graph 

Percentage Bar Graphs 

A percentage bar graph contains one bar for every label in the axis range. Each 
bar contains a section for each label in the legend range. The size of a section 
represents the percentage of the sum the value associated with that section 
occupies. 
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Figure 3-10 illustrates a percentage bar graph. The first bar shows that Salary 
represents 67% of income in 1980, Interest represents 22%, and Dividends 
represent 11 %. 
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Figure 3-10 
Percentage Bar Graph 

Line Graphs 
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A line graph is a set of connected points. Graph draws three different kinds of 
line graphs: simple, stacked, and percentage. 

Simple Une Graphs 

A simple line graph has lines ~ith different markers. For every label in the 
axis range, there is a different set of markers; for every label in the legend 
range, there is a marker of a particular type at each point on the horizontal 
axis. A line connects markers of the same type. The magnitude of values is 
represented along the vertical axis. 
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Figure 3-11 illustrates a simple line graph. The legend range is set to the legend 
label strip (Bl:Dl), and the axis range is set to the axis label strip (A2:A9). 

The line with square markers represents Salary; the line with diamond markers 
represents Interest; and the line with oval markers represents Dividends. 
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Figure 3-11 
Simple Line Graph 
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Stacked Une Graphs 

A stacked line graph presents the sum of the values across the labels. The first 
line graph is created by drawing a filled line chart for the values associated with 
the first label. The second line graph is created by drawing a filled line chart 
for the values associated with the second label above the line for the first label. 
Thus, the line represents the sum of the values of the first and second labels. 
The third line graph is created by drawing a filled line chart for the third label 
above the line for the second label. The resulting line represents the sum of the 
values of the first three labels. Figure 3-12 illustrates a stacked line graph. 

The solid section represents Salary; the checked section plus the solid section 
represent Salary plus Interest over that period; the three sections together 
represent Salary plus Interest plus Dividends, or income. 
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Figure 3-12 
Stacked Line Graph 
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Percentage Une Graphs 

A percentage line graph represents the percent of values across labels. Figure 
3-13 illustrates a percentage line graph. 

The solid section represents Salary; the checked section represents Interest. 
From this graph we can see that, although Salary increased over the time period, 
the percent of income that is salary decreased. 

Figure 3-13 
Percentage Line Graph 
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Point Graphs 

A point graph plots unconnected points. 

A simple point graph is like a line graph, except that points with the same 
markers are not connected. Figure 3-14 illustrates a simple point graph . 
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Scatter Graphs 

A scatter graph plots a set of points and the straight line that best fits them. 
The method of least squares (or linear fit) is used to find that line. Figure 3-15 
illustrates a scatter graph. 
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Figure 3-15 
Scatter Graph 

Pie Charts 

A pie chart consists of a single pie or a set of pies. For every label in the axis 
range, there is a pie; for every label in the legend range, there is a wedge of 
a particular pattern. The relative magnitude of the values is represented by the 
size of the wedge. 
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Figure 3-16 illustrates a pie chart. The legend range is set to the legend label 
strip (Bl:Dl), and the axis range is set to the axis label strip (A2:A3). 

- The solid wedges represent Salary; the checked wedges represent Interest, and 
the waffled wedges represent Dividends. 

Window size also affects how pie charts display. If you graphed the same data 
into a tall, narrow window, the pie charts would appear vertically rather than 
horizontally. 

Sometimes you may notice that the sum of pie chart percentages may not equal 
precisely 100 percent. Graph rounds calculations to the nearest tenth of one 
percent to simplify display. 

Figure 3-16 
Pie Chart 
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Attributes 

The attributes of a graph determine its representation. Graph provides menus 
for changing the graph attributes. The attribute set of a graph depends on the 
graph type. 

Bar, Line, and Point Attributes 

Bar, line and point graphs have the following attributes: 

Legend range 
The label strip associated with the legend. This setting can be a letter 
range, a number range, or a cell range. 

Axis range 
The label strip associated with the axis. This setting can be a letter 
range, a number range, or a cell range. 

Show legend 
An indicator that determines whether or not the legend box is displayed. 
This setting is either YES or NO. 

Axis lines 
An indicator that determines whether the axis lines are enclosed in a 
box, have only the corners drawn, or have no delineation. This setting 
is BOX, CORNER, or NONE. 

Grid lines 
An indicator that determines which grid lines are drawn. This setting 
is HORIZONTAL, VERTICAL, BOTH, or NONE. 

Horizontal axis limits 
The high and low limits and the increment used on the horizontal axis 
can be specified. This setting can be either AUTOMATIC (directing 
Graph to select the values that give the best representation) or a numeric 
or date value. 

Vertical axis limits 

Graph 
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The high and low limits and the increment used on the vertical axis can 
be specified. This setting can be either AUTOMATIC (directing Graph 
to select the values that give the best representation) or a numeric 
value. 

Text strings for a graph title, subtitle, and footnote can be specified. 
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Horizontal axis 
Text strings for a horizontal axis heading and subheading can be specified. 

Vertical axis 
Text strings for a vertical axis heading and subheading can be specified. 

Legend heading 
A text string for the legend heading can be specified. 

Pie Chart Attributes 

A pie chart has the following attributes: 

Legend range 
The label strip associated with the legend (wedge patterns). This setting 
can be a letter range, a number range, or a cell range. 

Axis range 
The label strip associated with the axis (pies). This setting can be a 
letter range, a number range, or a cell range. 

Label format 

Graph 

The label format can be specified. This setting can be Label and Percentage, 
Label and Data, Label Only, or Legend Box. 

A text string for the title, subtitle, and footnote can be specified. 

Patterns and Colors 

The legend associates a pattern with a bar graph or pie chart, and a marker 
with a line graph. If color is available, the legend also displays color. 

Graph Type 

Bar 
Line, Point 
Pie 

Legend Association 

Pattern (and color) distinguish the bars. 
Marker (and color) identify the points. 
Pattern (and color) distinguish the wedges. 
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Figure 3-17 
Menus for Black-and-White and for Color 

If you have a black-and-white system, the Style Menu presents 14 possible 
patterns. If you have a color system, the menu presents 14 possible patterns 
and 7 possible colors (see Figure 3-17). You can have as many as 14 different 
colors in your graph by using the black pattern with a color to get a vivid shade 
and the gray pattern with the same color to get a pastel shade. 

Highlighting 

Highlighting provides a means to draw attention to certain elements of the 
graph. Highlighting varies for different graph types. 

Graph Type 

Bar 
Line, Point 
Pie 

Default Format 

Highlighting 

Highlighted bars appear 3-dimensional 
Highlighted lines are thicker 
Highlighted wedges are separated from the pie 

A default format specifies settings for the graph type, legend and axis range, 
graph title and heading strings, pattern and color selections, window sizes and 
positions, and other settings. A default format completely specifies the repre­
sentation of the graph, but includes no actual data for the data grid. 
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Standard Default Format 

The standard default format has the following settings: 

Type: BAR 
Legend Range: A:J 
Axis Range: 1 :30 

Show Legend: 
Axis Lines: 
Grid Lines: 
Horizontal Axis Limits 

High: 
Low: 
Increment: 

Vertical Axis Limits 
High: 
Low: 
Increment: 

Creating Your Own Default Format 

YES 
BOX 
HORIZONTAL 

AUTOMATIC 
AUTOMATIC 
AUTOMATIC 

AUTOMATIC 
AUTOMATIC 
AUTOMATIC 

You can create, save, and load your own default format. To create and save a 
default format, do the following: 

1. Choose the "Clear all" option on the File/Edit Menu to clear the data 
grid. 

2. Change whatever graph settings and window parameters you like, 
using the various menus. 

3. Choose the "Save data" option on the File/Edit Menu to save the 
format in a file. 

This creates a file that contains only format settings. It contains no data for the 
data grid. 

Using Your Own Default Format 

To use a default format, choose the "Load data" option from the File/Edit Menu 
and specify the name of the file in which you saved your default format. 

When you load a file that contains no data for the data grid, the data that is 
currently in the data grid is not cleared. Thus you can change the graph format 
settings and window parameters for your current data in this way. 
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Using the Application 

The Main Menu has four hanging menus: File/Edit, Graph, Text, and Format. 
The keys labeled F11 through ADDTNL OPTIONS on the keyboard correspond 
to these four different menus (see Figure 4-1). 

Addtnl 
F11 F12 F13 Options 

DODD 
t t i i 

File/ Graph Text Format 
Edit 

Figure 4-1 
Menu Keys 

When you press a menu key, Graph displays the associated hanging menu. You 
select an item from the hanging menu by using t or f to move the cursor bar 
onto the option. 
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FILE/EDIT MENU 

The File/Edit Menu lets you perform a variety of operations. Figure 4-2 shows 
the File/Edit Menu. 

Full 1cr11n graph 
R1dr1w graph 
Pick pattlrns 
Chll'lgt column width 
Clur all 

R11d from clipboard 
Writt to clipboard 

Figure 4-2 
File/Edit Menu 
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Press F11 to see the File/Edit Menu. Select an option and press DO, or press 
EXIT to leave the menu. 

Full Screen Graph 

Place the cursor bar on the "Full screen graph" option of the File/Edit Menu, 
and press DO to see an enlarged version of your graph. Press RESUME to 
remove the full screen graph. 

Redraw Graph 

The "Redraw graph" option is equivalent to pressing the DO key. Graph redraws 
the graph using the the current values in the data grid and the current format 
settings. Position the cursor on the "Redraw graph" option of the File/Edit 
Menu, and press DO. 
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Pick Patterns 

The "Pick patterns" option lets you select a pattern or highlight for the labels 
in the legend box. If you are using color, then the menu includes color selections. 

Position the cursor bar on the "Pick patterns" option, and press DO to see a 
menu that consists of two sections. The first section shows you the current 
settings for each legend label. The second section shows you all the possible 
settings. 

To change the color, pattern, or marker associated with a legend label, move 
the cursor to the current setting for that label, and press DO. Graph lights a 
second cursor so that you can select the new color, pattern, or marker. Move 
the cursor to the desired setting and press DO again. Repeat this process to 
change the settings for other legend labels. 

Press EXIT to accept these changes and return to the data/graph state. 

To change the highlight setting for a legend label, position the cursor to the 
current setting (either YES or NO), and press DO. The highlight setting changes 
in response to the DO key. 

When you are satisfied with the current settings, press EXIT to accept them. 
If you want to restore the settings to the initial values, press CANCEL. 

Change Column Width 

The "Change column width" option lets you adjust the widths of the columns 
on the data grid. If your data values are small, you can narrow the columns to 
fit more information in the data grid window. If your values are large, you can 
widen the columns. If you have both large and small values, you can widen 
some columns and narrow others. 

To change the width of a column in the data grid, position the cursor in that 
column, press F11 to get the File/Edit Menu, and choose the "Change column 
width" option. 

Observe that the right boundary line of the column is now slightly thicker. You 
can move that boundary with• or .... When you have the column width that 
you want, press DO. The column is adjusted, and you are returned to the data/ 
graph state. 
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Clear All 

The "Clear all" option removes all data from the data grid and restores the 
standard default format, except for the window parameters, which are not 
affected by this option. 

Press DO to clear the data grid and restore the standard default format. 

Read from Clipboard 

The "Read from clipboard" option lets you get information from the clipboard. 
You can read data from Spreadsheet, Datamanager, or a previous use of Graph. 

Write to Clipboard 

The "Write to clipboard" option lets you put information on the clipboard for 
other applications. You can put either the data or the graph on the clipboard. 

When you put the data on the clipboard, it is saved in two formats: 

□ All the data, format settings, and window parameters are saved. The 
data values can be used by Spreadsheet or Datamanager. (If the 
clipboard is read back into Graph, the format settings and window 
parameters are also restored.) 

□ The screen representation of the data grid is saved (as a two­
dimensional table) for use by PROSE PL US. 

When you put the graph on the clipboard, it can be used by PROSE PL US. 

Save Data 

The "Save data" option lets you save the data, window parameters, and the 
format settings in a file. You can then load that file at another time to recreate 
the graph. 

With the cursor bar positioned on the "Save data" option, press DO. Graph asks 
you to confirm the name of the file in which to save the information. If you 
want to change any part of the file specification, use <:ZJ to remove the default 
value and enter a new value. 

When you press DO, the information is saved in the file you just specified. Later, 
when you press EXIT to leave Graph and then select "Save" to save the data, 
Graph also saves the information in this file. 
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Save Graph 

The "Save graph" option lets you save the graph as a GIDIS file. You can then 
use file services to print the graph. 

The graph that is saved is the same size as your current window. To change 
the size of this graph, therefore, you must change the size of the current window. 

With the cursor bar positioned on the "Save graph" option of the File/Edit Menu, 
press DO. Graph asks you to confirm the name of the file. If you want to change 
any part of the file specification, use <2] to remove the default value and enter 
a new value. 

When you press DO, the information is saved in the file you specified. 

Load Data 

The "Load data" option lets you restore the data grid, graph format settings, 
and window parameters. 

With the cursor bar positioned on the "Load data" option press DO. Graph lets 
you select the file you want to load. 

If data values are present in the file, the data grid is cleared before the new 
values are loaded from the file. If the file contains only format settings and 
window parameters (no data values), the data grid is not cleared and the data 
values are not changed. 
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GRAPH MENU 

The Graph Menu is a setup menu with three options: Type, Legend range, and 
Axis range. Figure 4-3 shows the Graph Menu. 

Figure 4-3 
Graph Menu 
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2793; 
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:filITII to accept valUH. 

Press F12 to get the Graph Menu. 

Press EXIT to accept any changes and leave the menu. If you use +-or-+ to 
move to another menu, Graph assumes that you are satisfied with the settings 
and accepts the changes. Press CANCEL to reset any changes. 

Type 

The "Type" option lets you select the graph type: bar, line, point, or pie. 

To change the graph type, position the cursor bar on the "Type" option of the 
Graph Menu. Press DO to display the possible graph types. Position the cursor 
bar on your choice of graph type, and press DO. 

To exit without changing the graph type, press EXIT. 
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Legend Range 

The "Legend range" option lets you specify the labels in the graph legend. The 
settings of the legend range and the axis range are related. The legend range 
and axis range settings must designate an intersecting area of cells in the data 
grid. 

To change the legend range, position the cursor bar to the "Legend range" 
option on the Graph Menu. Use ._ or ➔ to position the cursor and <Zl to 
remove characters. Type characters to insert them in the range. Press RETURN 
to complete the entry. 

Axis Range 

The "Axis range" option lets you specify the labels that are associated with the 
horizontal axis of the graph. The settings of the legend range and the axis range 
are related. The legend range and axis range settings must designate an intersecting 
area of cells in the data grid. 

To change the axis range, position the cursor bar on the "Axis range" option 
on the Graph Menu. Use ._ or -+ to position the cursor and <Zl to remove 
characters. Type characters to insert them in the range. Press RETURN to 
complete the entry. 

71 



CHAPTER 4 i GRAPH USER'S GUIDE 

TEXT MENU 

The Text Menu is a setup menu to provide labeling information for the graph. 
The options depend on the graph type. Figure 4-4 shows the Text Menu . 

. ,raph 
Title: Subtjtle: __________________ _ 
Footnote: __________________ _ 

.izontal ax.is 
Htadin9: 
SubhHdin9: -------------------

Vertical ax.is 
Htad.in9: 
SubhHdm9: _____ _ 

L19end hHding: _____ _ 

Figure 4-4 
Text Menu 

To enter text for any label field, position the cursor on the option. 

□ Press <:zl to remove a character. 

□ Use ~ or ..,. to move the cursor. 

□ Press RETURN to conclude the entry. 

You can use leading blanks to change the position of the text within the graph 
window. 
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FORMAT MENU 

The Format Menu is a setup menu with various options that depend on the 
graph type. Figure 4-5 shows the Format Menu for all graph types except pie 
charts. 

Press ADDTNL OPTIONS to see the Format Menu. Position the cursor bar on 
an option, and press DO to change the option, or enter a new value for the 
setting and press RETURN. Press EXIT to accept the changes and leave the 
menu. If you use ~ or ..,. to move to another menu, Graph assumes you want 
to accept any changes. Press CANCEL to reset any changes. 

Figure 4-5 
Format Menu 
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Show Legend 

The legend box displays the association between columns or rows in the legend 
range and patterns and colors. The legend box takes up space in the graph 
window, so Graph draws a smaller graph when the legend box is displayed. 

The DO key toggles the "Show legend" option from YES (show legend box) to 
NO (do not show legend box), and back again. 

If the legend range is given in terms of letters or numbers, the legend shows · 
the pattern associated with each relevant letter (or number). Only letters (or 
numbers) of rows (or columns) that contribute data to the graph are displayed 
in the legend. 

If the legend range is given in terms of cells, the legend shows the pattern 
associated with each legend range label. 

Axis Lines 

Graph can draw the graph within a box, in a half-box, or open. 

Position the cursor bar on the "Axis lines" option on the Format Menu. Press 
DO to display the three choices. Position the cursor bar on your choice and 
press DO. Figure 4-6 illustrates the three axis line options. 
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Graph 
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Figure 4-6 
Axis Line Options 
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Grid Lines 

Graph can include horizontal grid lines, vertical grid lines, both, or none. 

Position the cursor bar to the "Grid lines" option on the Format Menu. Press 
DO to display the four choices. Position the cursor bar on your choice and press 
DO. Figure 4-7 illustrates the four grid line options. 
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Figure 4-7 
Grid Line Options 
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Horizontal Axis Limits 

The horizontal axis has three limits: 

□ Low Limit - The value of the leftmost point 

□ High Limit - The value of the rightmost point 

□ Increment - The size of the axis divisions 

To change one of the horizontal axis limits, position the cursor on the horizontal 
limit you want to change. Use <:ZJ to remove the existing limit and enter either 
a value or the word AUTOMATIC and press RETURN. 

The standard default format supplies the AUTOMATIC setting. An AUTOMATIC 
setting directs Graph to derive the limits from the data. The low limit is derived 
from the smallest data value associated with the axis; the high limit is derived 
from the largest data value associated with the axis; and the increment is the 
best division between those two points. 

If you supply a value for a limit, that value must agree with the type of the 
values used as axis labels. You can give limits for the horizontal axis if it is 
labeled with numbers or dates. 

Sometimes, however, Graph may not have enough room on the screen to draw 
a graph that accommodates the horizontal limits and increments that you supply. 
For instance, you may supply a low limit of O units, a high limit of 80,000 units, 
and an increment of 10. To draw such a graph, Graph would need far more 
space than is available on the screen. Because it has only a limited amount of 
space, Graph gives you an error message, then uses the limits you specify to 
calculate a more suitable increment, and draws the graph using that increment. 
This increment may not be the one you want, however. You can change the 
increment by adjusting the horizontal limits until Graph can accommodate both 
the limits and the increment you specify. 

Similarly, the limits you specify may produce a graph that is so compressed you 
cannot distinguish one bar in the graph from another. For instance, bars occurring 
close to the vertical axis in the above example may be indistinguishable on the 
screen from the vertical axis itself. You can correct this situation by specifying 
different limits. 
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If the horizontal axis is labeled with dates, you can use months, days, or years 
for the increment. For example, you could specify an increment as 10 days by 
entering 10. Figure 4-8 illustrates the effect of changing the horizontal high 
limit. 

Graph 
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Figure 4-8 
Effect of Horizontal Limits 

Vertical Axis Limits 

The vertical axis has three limits: 

Graph 
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□ Low Limit - The value of the bottom point 

□ High Limit - The value of the top point 

□ Increment - The size of the axis divisions 

To change one of the vertical axis limits, position the cursor on the limit you 
want to change. Use <Zl to remove the existing limit. Enter either a numeric 
value or the word AUTOMATIC and press RETURN. 

Sometimes, however, Graph may not have enough room on the screen to draw 
a graph that accommodates the vertical limits and increments that you supply. 
For instance, you may supply a low limit of 0 units, a high limit of 100,000 
units, and an increment of 10. To draw such a graph, Graph would need far 
more space than is available on the screen. Because it has only a limited amount 
of space, Graph gives you an error message, then uses the limits you specify 
to calculate a more suitable increment, and draws the graph using that increment. 
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This increment may not be the one you want, however. You can change the 
increment by adjusting the vertical limits until Graph can accommodate both 
the limits and the increment you specify. 

The standard default format supplies the AUTOMATIC setting. An AUTOMATIC 
setting directs Graph to derive the limits from the data. The low limit is derived 
from the smallest data value associated with the vertical axis; the hip-h limit is 
derived from the largest data value associated with the vertical axis; and the 
increment becomes the best division between these two points. 

Figure 4-9 illustrates the effect of changing the vertical axis settings. 
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Figure 4-9 
Effect of Vertical Limits 
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The Format Menu is different for pie charts, because a pie chart does not have 
an axis. The only entry on the menu is "Label format." 

Labeling information is presented beside the pie wedges or in the legend. A 
wedge can be identified by its label and the percentage of the pie that wedge 
occupies, its label and the actual value of the data that created that wedge, or 
the label only. 

To change the label format, position the cursor bar on the "Label format" option, 
and press DO to display the four choices. Select one and press DO. 
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CHAPTER 4 , GRAPH USER'S GUIDE 

USING HELP 

You can get HELP in using Graph by pressing the HELP key. The first HELP 
you receive is a short HELP message that tells you something about the current 
option or state and the keys you can use in that state. The HELP frame concludes 
with some options for additional HELP. 

Select an option and press DO for HELP on that topic. If you choose the "HELP 
index" option, you are shown the Graph HELP Index, a list of the topics on 
which HELP is available. The Graph HELP Index serves as a reference list 
from which you can learn about all of Graph's features .. 

You can use NEXT SCREEN to move forward through the HELP information, 
and PREV SCREEN to move backward. 

PRINTING GRAPHS 

If you want to print a graph, choose "Save graph" from the File/Edit Menu. 
The graph is saved in the file you specify. You can print the file using Synergy 
File Services or P/OS menus. See your Hard Disk System User's Guide for 
details. 

LEAVING THE APPLICATION 

When you want to leave Graph, press EXIT. Graph displays a menu. This menu 
allows you to save any changes you have made since you entered Graph or since 
you used the File/Edit Menu to save your data. 

If you want to abandon any changes you have made, select "Quit" and press 
DO. Graph returns you to P/OS or the Synergy Main Menu. If you want to 
save your changes, select "Save" and press DO. Graph saves your information · 
in a data file. If you used the File/Edit Menu earlier to save your data, this 
data file is the file you specified then. Otherwise, it is the file you specified when 
you entered Graph. After the data file has been written, Graph returns you to 
P/OS or the Synergy Main Menu. 

If you want to return to your graph and continue working instead of exiting 
Graph, press EXIT again. 
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Appendix A 

Printing and Plotting Graphs 

Printing and plotting graphs with Synergy Graph is an easy process provided 
you have the necessary equipment, and follow the instructions supplied in this 
section. 

RECOMMENDED EQUIPMENT 

Depending on your requirements, you may need some additional equipment. 
Graph can be used without a printer or plotter, but you will need either a printer 
or a plotter to make copies of your graphs. You can print the graphs on either 
a DIGITAL LA50 or LAl00 printer. Each of these printers is packaged with 
installation and operation instructions. 

You can also plot graphs that contain up to seven colors (including white). If 
you want to create color graphs, you should have a color monitor (Model No. 
VR241) and a color monitor cable (Model No. BCC03). You also need to install 
an Extended Bit Map Option (Model No. VC241) to display color or shades of 
gray on your monitor. If you do not need to display colors or shades of gray, 
you can run Graph without this option. 

Graph can use either a two-pen or a six-pen plotter. The following plotters work 
with your Professional: 

o DIGITAL L VP16 (six-pen) 

□ Hewlett-Packard 7470A (two-pen) 

□ Hewlett-Packard 7475A (six-pen) 
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APPENDIX A 

SETTING UP THE PLOTTER 

Refer to the documentation that comes with the plotter for installation instructions. 

To connect the plotters to the Professional, you need the following equipment: 

□ Use the Hewlett-Packard Eavesdrop cable (No. 07470-60090) to 
connect both a plotter and a printer to your Professional. You also 
need the Digital printer cable supplied with your system unit. 

□ Use the Digital printer cable (Order no. BCC05-l0IJE) and the 
Digital Male-to-male RS-232 cable (Order no. BC22H-02IJN) to 
connect only a plotter to your Professional. 

To use the plotter with your Professional, you must set the plotter's rocker 
switches as follows: 

□ Set switches Bl and B4 to ON. Move the switches so they point to 
Bl and B4. Switches B2 and B3 should remain OFF. 

□ The next two switches on the 7475A plotter, and the next switch on 
the 7470A plotter, control paper size. Set these switches according to 
the instructions in the plotter documentation. 

□ If you are connecting both a printer and a plotter, set the YID switch 
to the Y setting. If you are connecting only a plotter, set the YID 
switch to the D setting. 

□ Set the SI and S2 switches to the OFF position. 

USING THE PRINTER AND PLOTTER 

If your Professional is connected to both a printer and a plotter, make sure that 
both the printer and the plotter are plugged in, turned on, and on-line before 
you print or plot a graph. To resume using the plotter or printer after you have 
turned the plotter off, turn both the printer and the plotter on again. (If the 
printer is already turned on, you will have to turn it off and then turn it on 
again.) 
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CAUTION: Wait until your graph has finished printing or plotting before you 
shut off the printer or the plotter. Otherwise, your data will be lost. 



APPENDIX A 

If the plotter will not draw your graph, check the following: 

□ Make sure the cables are connected. 

□ Check both the plotter and the printer to ensure that the power 
is ON. 

□ Make sure that the rocker switches are set as described above. 
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